
Workbook

GuideDragon speech recognition
Professional solution

For v15 of:



Copyright  2016 Nuance Communications, Inc. All rights reserved iii 

 

Version 15 End-User Workbook (August 2016, revision 1) 

 

Unless indicated otherwise, the material in this workbook applies to all editions of Dragon, and 
the screenshots are from the Professional Individual edition.  

Note: Closing all programs before installing is recommended. 

This workbook assumes that Dragon 15 is now installed on your PC. For details on how to 
install, including installing over a previous version, please see the Installation Guide on the 
Nuance website.  

 

 

 

 

The printable reference card includes important notes about installing as well as punctuation, 
numeric data, and commands.  

The online Knowledge Base contains the latest information written by Technical Support, the 
latest printable documents, as well as details on recorders and other hardware tested with 
Dragon. 

The Nuance website (www.nuance.com/dragon, australia.nuance.com/dragon, 
newzealand.nuance.com/dragon, and www.nuance.co.uk/dragon) offers many other resources 
including videos and Customer Service information.  

It also lists Value-Added Resellers who provide support, training and customization 
services in person or remotely. These partners can address your situation, workflows and 
goals; this is particularly efficient for busy people, for people new to computers, for children, 
and in case of issues with hearing, vision, mobility or dyslexia.  
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Goals and Prerequisites 

Dragon is software for Windows computers that lets you speak naturally to perform actions such as creating or 
editing documents, using e-mail, finding online maps, news, images, and more. By reducing keyboard and mouse 
usage, you can gain productivity AND avoid physical strain (on wrists, shoulders, neck, eyes…)  

Speaking to your PC may feel strange at first. Be patient with yourself! This workbook aims to efficiently present 
what an end-user should know: most importantly, how to “type by voice” efficiently. This includes: 

 Dictating anything: punctuation marks, prices, dates, URLs, phone or plate numbers, abbreviations, 
acronyms, Roman numerals, etc. 

 Personalizing the Vocabulary with custom words and phrases, pronunciations, capitalization properties 
and more, so that Dragon can transcribe exactly what you want, even if what you said could be written in 
different ways. 

 Correcting Dragon’s errors so that it can learn from them. 

 Formatting, editing, and revising text, whether or not it was created by voice. 

 Creating custom commands to insert boilerplate text and/or graphics. 

 

In addition, you can learn how to command your computer by voice, which includes: 

 Saying commands to use the Web and e-mail, search your computer, open programs, click menus and 
buttons, close or minimize windows, switch between windows, etc.  

 “Voice-pressing” a key (or key combination) on your keyboard. 

 

To perform the exercises in this workbook, you should have basic familiarity with: 

 Using Microsoft® Windows® to start or exit applications, open or save files, copy or move items, browse 
to folders, cut and paste, etc. 

 Word-processing concepts such as bullets, font size and style, bolding, italicizing, and right-aligning. 

 

Efficiency and hands-free usage 

We strongly recommend going through this workbook in order. When a lesson directs you to click an item (button, 
menu…), feel free to instead use your voice, or keyboard shortcuts (underlined letters, Tab, spacebar…). If 
hands-free usage is important to you, start by reading the lesson Controlling the Operating System and 
Applications and see the Help about MouseGrid and commands for moving, clicking, and dragging the mouse. 

 

IMPORTANT: Starting the Microphone Check or the Interactive Tutorial automatically turns off Dragon’s 

microphone, which means a manual action is then needed to resume using Dragon. If this is a concern for you, 
we recommend having a helper with you when you create or upgrade a profile, use the Interactive Tutorial, or use 
the Microphone Check.  
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Getting Started and Creating a Profile 

Dragon is speaker-dependent. It relies on information specific to you, including what words and phrases you use often, 
how you sound, what audio device you use, and what settings you have; it stores this in a set of files referred to 
collectively as your “user profile” or just “profile.”  

Each person who uses Dragon must have his or her own profile. Your profile is important; the more personalized it is, the 
better your experience will be. To have the best start, it’s worth creating your profile carefully or upgrading it from a 
previous version of Dragon.  

This lesson covers creating or upgrading a profile, but first let’s address what Dragon needs in order to get good audio 
input from you.  

 

Positioning and connecting your microphone 

If using a headset, adjust it so that it feels stable and comfortable; it shouldn’t press your 
temple or glasses. The microphone’s listening side must face the side of your mouth, not 
the front. It mustn’t touch hair or catch breathing sounds. (On standard headsets, bend 
the “boom” if needed.)  

Most headsets can be rotated so you can place the microphone on either the left or the 
right side of your face. 

Experiment to find what works best for you then aim for consistency in your microphone 
position whenever you use Dragon. 

 

IMPORTANT: 

 Noise-canceling microphones only listen on one side. The listening side is often 
marked by a dot or the word TALK, which may not be visible unless you lift the foam 
cover slightly. Check that this side is parallel to your face, not tilted. 

 

 

 

 

 

 

 If you want to bypass your computer’s sound system, you can use a USB 
microphone, or plug your regular microphone into a USB adapter. 

 
 

 If your computer has only one audio jack (socket) and you want to use a regular two-
plug microphone, you must use a USB adapter or a Y-shaped adapter. 

 
 

 When you plug a microphone or adapter into your PC, be sure to push all the way into the audio socket or USB port. 

 

 If you want to test your microphone independently of Dragon, you can use Sound Recorder, a Windows accessory 
(accessible from the Windows Start menu or Start screen).  
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 You may also wish to check the audio settings at the level of 
Windows: see the “Recording devices” section of the Control 
Panel. This is accessible by right-clicking the loudspeaker icon 
on the System Tray. (In the example illustrated here, both 
Bluetooth and USB are available.) 

 

 

 
 

 Some PCs, after you connect a microphone, automatically 
bring up a small window associated with this “audio system 
event”. (Its window may be hidden behind other windows.) 
Before closing this window, verify that what is highlighted on it 
is the Microphone item (and not the Line In item).  

 

 

 

 

 If your microphone model has a mute switch, make sure it is in the ON position! 

 If you use a Bluetooth microphone: whenever you use Dragon, make sure that it is not only powered up but also 
active (that is, in “call mode”). Please see your microphone’s user guide for details, including how to charge the 
headset and how to pair it if necessary. 

 

Upgrading one or more profiles 

Dragon 15 can upgrade profiles from Version 13 or 14. If you have such a profile, you should upgrade it and use it in 
Dragon 15; this allows you to benefit from refinements you had previously made, including acoustics, optional settings, 
and vocabulary, plus custom commands if applicable. 
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The Upgrade Wizard, available from the Start screen 
under Dragon Tools, can automatically detect eligible 
profiles on your computer. Use its Remove button as 
needed so that only the desired profiles appear. 

If a profile you want to upgrade isn’t in the list (for 
example because it is on an external disk), use the 
Browse button to designate it. 

Once the list contains only the profile(s) you wish to 
upgrade now, click Next.  

 

 

IMPORTANT: After the upgrade completes, launch Accuracy Tuning to ensure that your profile can benefit from all 

your previous acoustic data. See the Audio menu and Help for details. 

 

Adding and managing sources 

If you already have a profile and want to use another type of audio input, add a source to your profile instead of creating a 
separate profile: open the Profile menu and pick Manage Dictation Sources, which opens the box where you can pick 
the desired source. 

Remember: personalizing the Vocabulary is one of the keys to getting Dragon’s full benefits! Having multiple sources 
within a profile means that, no matter which input device you use, the same Vocabulary will be used—and refined—each 
time you use Dragon. For example, the phrases and capitalization properties you taught Dragon while using the built-in 
array microphone as a source will also be available when you use a USB microphone, and vice versa. 

About spoken recordings as source 

Dragon works with one voice at a time; it can’t transcribe interviews or meetings directly. Its transcription feature can be 
particularly useful to exploit what you dictate while observing something (such as during a field inspection) or after an 
event (such as after a meeting or a class). Once your profile is set up for transcription, you can use Dragon to transcribe 
recordings. Setting up a transcription source can be done using a sample of your own recorded voice, or someone else’s. 

 

TIP: If your recording contained several voices or was so “rough” that it’s hard to transcribe, consider “re-speaking” 

rather than (or in addition to) having Dragon transcribe it: while listening to it and pausing it as needed, you dictate to 
Dragon what you hear. Among other advantages, this gives you the opportunity to improve upon what was originally said, 
or add to it, including adding punctuation that hadn’t been spoken.  

 

Before recording files for Dragon to transcribe, note: 

 We recommend first using Dragon to dictate directly to your PC. This gives you a chance to practice speaking 
clearly, in long phrases, and with punctuation. From what you see Dragon transcribe as you dictate, you get 
feedback on how you are dictating. You also get ideas as to how to personalize the vocabulary, for instance by 
noticing jargon or phrases to add so that Dragon can write them with the spelling and capitalization you want.  
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 Learn the essential operations of your recorder. Also, verify that the recorder is set to the correct time and date as 
well as optimal settings for speech recognition (see details on models tested by Nuance at 
http://support.nuance.com/compatibility). 

 Some devices come with software to manage recordings including converting their format. Check your device’s 
documentation.  

Creating your profile—or adding an audio source  

This step-by-step process includes indicating your audio input type and verifying your sound system. 

Note:  

 Consistency matters! For best results, create your profile in your “normal” environment, with the same background 
noise and equipment as you will usually have when using Dragon. 

 If you already have a profile and just want to use another type of audio input, add a source to your profile instead 
of creating a separate profile.  

 (Unless you use a built-in microphone) Before you start Dragon, connect your microphone and, if you wish, test it 
by making a sample recording in Windows Sound Recorder. 

 For Bluetooth wireless headsets, see the Help and the manufacturer’s documentation (learn to charge the 
microphone, power it up, turn it on, and pair it). 

 

Step 1: Launch Dragon (double-click its desktop icon or pick it from Start). If Dragon hasn’t been used on this PC, the 
Profile Creation Wizard opens; otherwise, choose New User Profile in the DragonBar’s Profile menu, then click 
New. 

Step 2: Answer the questions presented. The wizard will ask you to specify a “region” so Dragon can choose your 
profile’s underlying Auto-Formatting options and Vocabulary. For instance, this will affect whether Dragon uses 
the spelling “colour” instead of “color” and how it writes currencies or units such as lbs, $, USD and AUD (ISO 
codes).  

 

TIP: Once your profile is created, you are free to customize it, including modifying Auto-Formatting Options and 

Word Properties as described in this workbook and the Help.  

 

Step 3: Indicate which type of audio source you are about to use. If you use a USB adapter on a standard headset, pick 
the USB option here. If your PC has only one audio socket (like on mobile phones), use a USB adapter or a Y-
shaped “splitter” with your regular microphone, or use a USB microphone. 

    

The Hardware Compatibility List on the Nuance website contains details such as the recommended settings for a 
particular model of microphone or recorder.  

http://support.nuance.com/compatibility
http://shop.nuance.com/store/nuanceus/en_US/pd/productID.205982000?resid=UCWoVAoBAlgAAFJizH4AAABA&rests=1344645204006
http://support.nuance.com/compatibility
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Step 4: Next is the microphone 
check. Read the boxed 
text in a clear voice, the 
way you plan to speak 
when working with 
Dragon. Here 
punctuation is 
recommended but not 
required. 

When Dragon lets you 
know it has heard 
enough, click Next.  

 

It’s best to read the text exactly as it is written. However, if you cannot read it, feel free to speak some sentences 
of your choice for about 30 seconds, in the same tone of voice you would use when dictating to your PC. 

Dragon then verifies that your sound system is acceptable for speech recognition.  

Note: Some computers offer several places to plug in your microphone. If you get poor results with one, consider 
the other (front or back, or for laptop users a docking station). Once you’ve identified which port works best, aim to 
always use that port for your microphone. (Considering marking it with tape.) 

Step 5: The wizard asks whether to have your profile participate in User Experience Collection, which helps improve 
Dragon by collecting usage data. This data will be analyzed by Research & Development to identify trends and 
help prioritize features. You can start or stop participating at any time by simply going to the Options dialog.  

After the last screen of profile creation, Dragon opens its Interactive Tutorial, short progressive simulations to help you 
discover and practice important aspects of Dragon usage. We recommend that all users take advantage of it.  

The Tutorial introduces Dragon’s options dialog, including hot keys (particularly relevant for people who use their numeric 
keypad for data entry or don’t have a full keyboard). This workbook progressively introduces options that most users 
should consider. Below are two of them. 

Important options 

After you create your profile, Dragon presents a message if it determined that your PC wouldn’t allow optimal 
performance. This informs you that Dragon has adjusted the defaults for two of its options:  

 The Speed versus Accuracy slider was moved toward speed. 

 The large sets of flexible commands for Microsoft Word, Excel, PowerPoint, and Corel WordPerfect were disabled 
(see the lesson “Controlling your Desktop and Applications”). 

Later, you can reverse these changes, depending on your particular needs: you can enable or disable the Natural 
Language Commands for individual applications and experiment with the slider.  

Note: Other options include having Dragon start in its sleep state (useful for persons who cannot use their hands), and 
disabling the “tracking” of menus, buttons and other interface elements or disabling the automatic Dictation Box where 
Dragon doesn’t have Full Text Control (for example in PowerPoint). Turning off some options can make Dragon work 
faster on your PC; consider the ability to open items from the Start menu or Desktop even at any time, and the shortcut 
commands to create new emails or tasks. 

We suggest you begin personalizing your profile as soon as possible. And if you’ve used a previous 
version of Dragon, see the Help’s What’s New.  
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Key points about getting started with Dragon 

 Each person who wants to use Dragon must have his or her own profile. Creating one is a short process guided 
by a series of screens.  

 Profiles from versions 13 and 14 can be upgraded to version 15. After upgrading, launch Accuracy Tuning from 
the Audio menu.  

 Make sure your microphone is properly connected and positioned, and the appropriate audio source is selected. 
See our website for details on special sources like recorders and wireless microphones. 

 You can add a source to an existing profile, for instance a USB microphone and your laptop’s built-in 
microphone. Whatever source is used, you will benefit from the same vocabulary and optional settings as well as 
custom commands, if applicable. 

 When reading text for the microphone check, speak clearly but naturally using the same volume, pitch and pace 
you are likely to use day-to-day.  

 Dragon's scheduled tasks are designed to help automatically improve accuracy. Schedule them for a time when 
your computer will be on but Dragon won’t be running. 
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Learning More and Getting Help 

Dragon offers so much that it would be impossible to cover it all in this workbook. This lesson presents ways to find more 
information as you start using the software—take advantage of them! 

Please see Dragon’s reference card, which includes important notes about installing Dragon as well as sample 
commands and how to dictate special characters, dates, and more. The latest printable documentation is available for 
download on the Nuance website. 

The Accuracy Center 

The most important features of Dragon are accessible directly from the DragonBar's menus. The Accuracy Center offers a 
central location to access all accuracy-related features.  

Step 1: Say Open Accuracy Center.  

Step 2: Click the link that interests you or say its name immediately preceded by the word "click”.  

 

TIP: You can activate links without saying their whole name: for instance, instead of click import a list of words or 

phrases, you could say just click import a list. 

 

The Help 

The DragonBar’s Help menu gives you access to the on-screen Help topics (articles).Another way to open the Help is 
saying open help.  

When entering keywords in the search field, you can indicate phrases by putting quotation marks around them.  

To launch a Help search at any time, no matter what is active on your screen, you can use the shortcut command “search 
Help for…” with the word(s) to find. For instance, you could say “search Help for Firefox commands”. The search 
keywords you name in this command will be considered individually unless you put them in quotes: for instance, “search 
Help for open-quote dictation box close-quote.”  

Dragon also provides contextual help: from its dialog boxes, a button or question-mark icon takes you directly to the 
relevant article in the Help. 

The What Can I Say command 

At any time, you can say what can I say, and Dragon will display a list of 5 commands applicable to the current 
application. You can then say any of those, omitting the word “show” if you wish. 

 

Note: you could say the listed commands anytime, without first saying what can I say. Saying formatting commands, for 
instance, displays commands related to formatting text: 
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The Interactive Tutorial 

Available from the Help menu, the Interactive Tutorial contains short progressive simulations and makes you practice 
important habits for efficient dictating, correcting, formatting and revising, using the Web, and customizing your profile’s 
options and vocabulary.  

It includes important editing commands such as “go back,” Dictation Commands such as “cap,” “all caps,” and 
“numeral…” as well an example of the Spelling Window and Smart Format Rules. We recommend that all users take 
advantage of it. 

Note:  

 When the Interactive Tutorial opens, Dragon automatically turns off its microphone. Each simulation includes 
turning the microphone on and off, an important habit to develop.  

 In the simulations, you must speak just the current prompt and do so in one breath, not pausing within it.  

The PDF guides 

The latest Installation Guide is available as a PDF on the Nuance website alongside the reference card and other 
resources. The Help menu gives direct access to the site’s User Documentation page. 

In the PDF, you can click headings to jump to specific topics and you can print out sections or the entire file. 

Note: If you use a Bluetooth microphone, be sure to read its documentation, charge the headset, pair it if necessary, and 
ensure it is not only powered up but also active (that is, in “call mode”).  

 

Key points about learning more and getting help 

 This workbook is meant to get you started efficiently and cover essential concepts and tips. Other resources 
include the Help, the Interactive Tutorial, the Accuracy Center, and the Nuance website. 

 Explore the Help menu. At any time, you can say open help or “shortcut” commands such as search Help for 
Roman numerals. 

 At any time, you can bring up a short list of applicable commands by saying what can I say. This replaces the 
Sidebar feature of previous versions. 

Consulting an experienced Dragon trainer for specific guidance and customizations can be particularly efficient for users 
who have special environments, workflows, or challenges (related to motion, vision or fluency, for instance). 

Now let’s learn the most important aspects of using Dragon, starting with an often-overlooked but crucial one: 
personalizing your profile’s Vocabulary 
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Why Personalizing the Vocabulary is Essential 

Transcribing a person’s speech presents acoustic challenges, such as accent and ambient noise. There is also a lexical 
challenge: for the transcription to be precisely accurate, familiarity with the terms used is necessary.  

For instance, even an experienced medical secretary would have trouble transcribing for an attorney’s office! And a 
newly-hired transcriptionist would have to not only get used to the accents of the various speakers, but also to learn what 
spellings and formatting they want, including acronyms, abbreviations, special phrases, names of people, places, 
products, etc.  

A name may seem commonplace to you because you use it frequently, but a person who hears it for the first time may not 
be able to spell it: that name isn’t yet a part of their vocabulary. Similarly, if a word or phrase isn’t in Dragon’s active 
vocabulary, the software can’t transcribe it correctly yet. 

When you created your user profile, you provided information which Dragon incorporated into its acoustic model. To get 
optimal accuracy, you should also help Dragon adapt its language model. This ensures that what you dictate is 
transcribed with your desired spelling, spacing, and capitalization; Dragon provides many powerful tools for it, so this 
important investment can be done quickly. You can even benefit from the customizations done by others.   

The Help system contains details and demonstrations about personalizing the Vocabulary.  

 

Key points about Vocabulary customization 

 As soon as you have created a profile, you can start dictating, but note that taking a moment to start customizing 
the Vocabulary is a good investment to make right away, since it helps Dragon “get it right the first time” (including 
capitalization) and it can be quick. Personalizing the Vocabulary early and often is strongly recommended. The 
following pages will show you how. 

 Dragon offers simple and powerful tools to make your dictations and transcriptions faster and more convenient.  
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Customizing the Vocabulary—Using the Vocabulary Editor 

Dragon’s Vocabulary Editor lets you view what can be transcribed from the computer’s active memory; it also allows you 
to add new entries and edit existing entries—including their Spoken forms and Properties. 

In this lesson, you explore the Vocabulary Editor.: 

 

Step 1: Say Edit Vocabulary (you can also use the Vocabulary menu or the Accuracy Center). The Vocabulary Editor 
opens; its scrollable window lists the entries currently in Dragon’s active Vocabulary.  

Take a moment to scroll through the list. You will see names of people, places, institutions and products, as well 
as common words, phrases, and abbreviations.  

Step 2: Open the Display drop-down list (located at the bottom) and choose Words Containing Spaces. Other Vocabulary 
displays include Words Containing Digits, Words Containing Capitalization, and Words with Special Properties. By 
browsing these, you can learn more about what the software uses to transcribe your dictation. You also get ideas 
about what entries you might add or edit. 

 

Adding word and phrases 

You can quickly search for a particular entry by entering it in the Search field. If it appears in the scrollable list, it is already 
in the active layer of the Vocabulary. If not, click Add to bring it in. 

CAUTION: When adding an entry to the Vocabulary, be sure to spell and capitalize it correctly! Otherwise, it will 

appear misspelled in your documents every time you dictate it. 
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Some of the "words" in the Vocabulary Editor aren't single words. Of course is listed. So is as well as. There are also 
names of people, places, products, and institutions: Mother Teresa, Madison Square Garden, KitchenAid, Brigham and 
Women's Hospital, Marine Corps, Library of Congress, Babe Ruth, Accounts Payable, George Washington, Johnson & 
Johnson, Division I, LAN Server…  

These help the software resolve spelling and capitalization ambiguities: if the Vocabulary didn’t contain the phrase Mother 
Teresa, dictating it would probably produce the transcription "mother Theresa"—because the word mother is usually not 
capitalized and Theresa is the more common spelling of the name. Having the phrase in its Vocabulary helps Dragon 
know that the words “Mother” and “Teresa” are likely to occur together, and hence helps Dragon choose the desired 
capitalization and spelling. 

Also, recognizing long sounds is easier than very short sounds. A and the are acoustically very similar, as are in and an. 
Longer words, like chrysanthemum, contain more acoustic information.  

We strongly recommend adding personal phrases; this will later save you time since you won’t have to adjust their 
spelling and capitalization after transcription.  

 

Exercise 1: In the Vocabulary Editor, search for names such as your first and last names, your town, company, 
colleagues or relatives, and if they are absent, add them.  

 

TIP: When adding names of people, consider variants such as nicknames and diminutives as well as formal names, 

particularly for names that are very short or that can be spelled different ways: for instance, one might add Liz Jansen, 
Lizzie Jansen, Elizabeth McGee Jansen, Jennifer B. Wolff, Jennifer Wolff, Jenny Wolff, Jenn Wolff, Judge Wolff, Scooter 
Wolff… 

This applies to more than just names. Whenever you add an item to the Vocabulary, think of its possible variations: 
singular/plural for nouns, conjugated forms for verbs… Remember, if something is not in the Vocabulary, the software 
cannot recognize it, so don’t hesitate to add items even if you think you won’t dictate them often!  

 

 

Exercise 2: Open a word processor (such as DragonPad, available from the Tools menu or the command “open 
DragonPad”) and start creating a list of Vocabulary entries relevant to you. Below are suggestions. (Soon you will 
learn how to import these entries all at once.)  

 jargon and phrases specific to your profession (such as distro, site visit and non-State) 

 names of places, facilities or organizations (such as Building 6A, or County Adoption Center) 

 names of products (such as Latex Exterior Semi-Gloss)  

 acronyms, part numbers, codes (such as FICA, 501c(3) or RX-70y) 

 names of people (coworkers, clients, relatives…) including phrases for names that can be spelled differently 
(Kristin, Gene, Steven, McGregor, Wolfe…) or are very short (Kip, Kit, Dee…), to avoid acoustic ambiguity. 

 

TIP: Consider obtaining lists such as personnel, departments, divisions, products, or trademarks, as well as glossaries 

of terms and acronyms. Starting from such lists doesn’t just save time; it may also help add these items with their official, 
correct spelling!  

 

The importance of spoken forms 
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Radio programs often tell their listeners “let us know how to pronounce your name” because some names could be 
pronounced in several ways and some are not pronounced “the way they are written” due to silent letters, for instance. 
This is true for more than just names. Acronyms are often pronounced letter by letter, but not always: ASAP is 
pronounced "ay sap" by many people. These facts are addressed by an important feature: the Spoken form. 

From the Display drop-down list of the Vocabulary Editor, choose “Words with spoken forms only.” Take a moment to 
scroll through and look at existing spoken forms; you will get ideas for what kinds of entries warrant them and how they 
can be written. 

 

You may add Spoken forms to custom entries and to existing entries, to dictate them as comes naturally to you: for 
example, to enter the symbol ©, you like to say “circle see” instead of “copyright sign.” 

Note that entries containing symbols, digits, or unusual spacing are particularly likely to warrant a Spoken form, so that 
there is no doubt as to how the item will be pronounced.  

If you add e-mail addresses, giving them a Spoken form can make them quicker to dictate: for instance, “Alex and John 
at yahoo dot com” or even just “Alex and John at yahoo” for AlexT&JohnB@yahoo.com. 
 
Spoken forms mustn’t include punctuation, abbreviations, or symbols. Below are a few examples. 

 
Written form: The Man from U.N.C.L.E 
Spoken form: the man from uncle 

 
Written form: Trenton-Mercer Airport 
Spoken form: Trenton Mercer Airport 

Adding Spoken forms allows you to dictate in the way that is most natural, but also quickest for you. In addition to 
indicating pronunciation, Spoken forms can be used for “vocal shorthand” and automatic substitution: you say something 
short and easy, and Dragon types something longer or “trickier” to say (or to remember).  

Spoken forms give consistency and clarity to your writing. Groups can take advantage of them to help everyone comply 
with guidelines such avoiding abbreviations and other confusable items.  

mailto:AlexT&JohnB@yahoo.com
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Deleting “words”  

If you encounter a word that Dragon doesn’t transcribe as you’d like, remember: that word might warrant a Spoken form or 
longer entry in the Vocabulary, and Dragon may need to “study” how and how frequently you use it so have Dragon 
analyze relevant text (see the Accuracy Center). Also, particularly if the pronunciation contains non-English sounds, 
consider “training” that word or phrase—see "Training Words".  

You may run into cases where a word you need is consistently transcribed as another word.  

If that other word isn’t important to you, deleting it from your profile’s active Vocabulary is a quick solution, eliminating 
“competition.” For instance: the names Schaeffer, Shaefer, Schaefer and Shafer all sound alike, so if you want Dragon to 
write “Schaefer” but it typically writes “Shafer,” delete “Shafer” from the Vocabulary. 

You can do this by finding and deleting the word in the Vocabulary Editor, or you can do it by opening the Correction 
menu over the unwanted word after Dragon transcribes it. 

Note: Dragon’s active Vocabulary comes with thousands of entries. Browsing the Vocabulary Editor, you’ll see many 
entries you won’t dictate, but don’t spend time deleting them unless they actually cause a conflict! 

There’s more you can do in the Vocabulary Editor! An important example is adjusting Word Properties.  

Modifying Word Properties  

By clicking the Vocabulary Editor’s Properties button, you open the dialog where you can view or change the 
capitalization, spacing and numeral properties of an entry. 

 

IMPORTANT: Use the Word Properties dialog to modify the Dictation Command “new line” if you want it to trigger 

capitalization of the following word. Similarly, you can set the ellipsis (…) to NOT trigger capitalization. 

 

In the Word Properties dialog box, you can also choose one or even two alternate written forms. 

For example, you may want: 

 the spelling “email” instead of the hyphenated “e-mail”,  

 the abbreviation “fig.” instead of the word “figure” just before numbers, as in “fig. 3”,  

 the title Professor instead of its abbreviation. 

Note: in the Vocabulary Editor, entries whose properties were modified have a “P” icon. 
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Key points about the Vocabulary Editor and Properties 

 You can open the Vocabulary Editor by saying the command edit vocabulary. Added entries are marked with a 
+. Choosing Custom words only from the Display drop-down allows you to see just them. 

 You can locate an entry by entering in the Search field its Written form or its Spoken form. By using the drop-
down, you can also browse subsets like “Custom words only” and “Words containing punctuation.”  

 Spoken forms are an efficient way to help Dragon transcribe words, particularly those that contain digits, symbols 
or silent letters. In addition to clarifying pronunciation, they allow you to say something different, shorter or easier 
than the Written form, such as “E O B stat” for “Explanation of Benefit (EOB) statement.”  

 If an entry you don’t need to dictate “competes” with one you do need, you can delete that entry (for instance, 
Cassidy vs. Cassity). To see what has been deleted, set Deleted words only as the Display. 

 You can view or change the Properties of entries, including spacing and capitalization. For instance, you can 
change whether Dragon writes “travelled” or “traveled” and whether the ellipsis (…) and the Dictation Command 
new line are followed by capitalization.  
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Importing Lists of Vocabulary Entries 

You now know how to add words and phrases one by one in the Vocabulary Editor. If you have many entries to add, this 
is not the most efficient method, particularly if you already have some relevant lists in electronic form. You can use the 
import feature to add many Vocabulary entries at once, even if they have Spoken forms.  

Observe the sample import list in the illustration below, and identify the motivation behind each entry. You can then make 
and import one or more lists of your own, as described below. 

 

To create and import lists of “words”: 

Step 1: Create a document (or edit an existing document) listing entries you want to add to the Vocabulary. You can do it 
in any word processor as long as you can save this document as plain text. 

 

 Have each entry on a separate line.  

 Make sure everything is spelled, capitalized and spaced correctly. 

 To include a Spoken form, follow the Written form with a backslash characterWritten form then the Spoken form: 
for example, Grb II\grab two.  

 

 

Step 2: Save this document as a .txt file (from the File menu, choose Save As and, depending on the word processor, 
choose Text Document, Text Only, or Plain Text), then close the file. 

Repeat as necessary with other lists. (You may find it convenient to make several lists, such as a list of friends 
and relatives, a list of professional contacts, a list of product names, a list of local landmarks, etc.) 

Step 3: Say import custom words, or use the DragonBar’s Vocabulary menu to pick “Import list of words or phrases.” 
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Step 4: On the resulting dialog box, click 
the Add File button.  

The Add File window appears. Locate the 
file containing your list and click Open; the 
name of the file you designated is now 
displayed in the File List. 

If you have other lists to import, add their 
files in the same way. 

 

Step 5: Click Next. The software will 
import the listed items into the 
Vocabulary. 

 

 

The imported entries will be viewable in the Vocabulary Editor, where a red plus-sign appears next to them (like for 
entries that were added by means other than an import list). 

From the Vocabulary menu, you can also export all custom-added words into one file. This is useful for safe-keeping or for 
import in other user profiles.  

Note:  

 You can choose .xml as an export format instead of .txt, so that Word Properties will be captured. 

 For files resulting from this export in Dragon version 11 or later, there are two items of note: the header 
@Version=Plato is added automatically, and spoken forms, if any, are separated by two backslashes instead of 
one. If you want to import such a file (as opposed to importing a file you made yourself), do not remove the 
header line and do not replace “\\” with “\”.  

 Exported word lists do not include trained pronunciations. 

 

 

Key points about importing Vocabulary lists: 

 You can add whole lists of Vocabulary entries at once. Prepare the list(s), then open Dragon’s list import dialog 
(you can say import words, or choose from the Accuracy Center or the Vocabulary menu). 

 Lists must be saved as plain text, and closed, before they can be imported. 

 Each entry must be on its own line. 

 To specify a spoken form in a word list, use a backslash (\) to separate it from the written form. 

 You can also export all custom-added words into one file (in .txt or .xml format). This is useful for safe-keeping or 
for import in another profile. 
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Customizing the Vocabulary from Existing Documents 

You now know about importing lists of entries into the Vocabulary. Another efficient way to boost your accuracy is to let 
Dragon analyze text that is similar to what you are likely to dictate: the tool Learn from specific documents can use many 
documents at once to “harvest” potential words to add to the Vocabulary, as well as to “adapt to the writing style” (i.e., 
learn frequency information). The greater the amount of relevant text Dragon analyzes, the better Dragon can adapt its 
Vocabulary to what you usually dictate. (This is similar to giving a just-hired transcriptionist documents in which to observe 
the terms used, their spellings, their context, etc.; doing so would help the transcriptionist get ready to transcribe your 
dictations most accurately.) 

The analysis tool supports Google Docs as well as the following: .txt (plain text), .rtf (Rich Text), .doc(x) (Microsoft 
Word), .wpd (Corel WordPerfect), and HTML formats. 

 

TIP: If significant text exists only in an application that doesn’t normally produce files of these types (PowerPoint is an 

example), see whether this application lets you copy text so you can paste it in the DragonPad and save it from there, or 
whether it offers a way to extract plain text (it could be called “export” or “save as outline” for instance.) Also, if essential 
text only exists as PDF or in paper form, consider using Optical Character Recognition software such as OmniPage to 
convert into one of the accepted formats.  

 

Step 1: Locate some electronic documents you have written—think of reports, letters, memos, proposals, etc. (As long as 
they are similar to what you intend to dictate, you can also use documents written by someone else.) The more 
closely these documents match the dictation you will usually be doing, the better.  

Step 2: Spell-check the documents if necessary (since Dragon would detect misspellings as unknown words.) In addition, 
remove any foreign-language sections that might be present. Then, make sure the documents are closed. The 
Help contains more details on this tool, including how to best prepare documents for analysis.  

Now that you have texts similar to your intended dictations, let’s designate them for analysis. (If you obtain more 
documents later, you can designate them to Dragon at that time.) 

Step 3: Say "switch to DragonBar", "Vocabulary" then "learn from specific documents." 

 

Checking the box “Adapt to writing 
style” will make Dragon learn 
frequency information, which 
increases accuracy since it helps 
differentiate between homophones 
like “world” and “whirled”.  

Leave this box checked unless you 
only want to “harvest” potential 
custom words—for instance, if the 
text is very different from your normal 
style, or contains a foreign language.  
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Step 4: On the Add Documents box, click Add Document. On the resulting window, locate and select the relevant 
document(s), then click Open.  

Note: 

 You can select multiple files at 
once by holding down the Ctrl key.  

 You can also press Ctrl A, the 
Windows hot key for “select all.” 

 

 

Dragon now analyzes the text contained in the designated documents. This may take a moment. If you have a lot 
of text to analyze, run this tool when you don’t need to use Dragon for something else.  

Dragon then presents you with a list of the “unknown” words it found, with a check box next to each one, and the 
number of times each word was encountered. The words found most frequently are at the top since they are most 
likely to be relevant, unlike those that only occurred a few times. 

Step 5: Adjust the list so that only the items you want to add are checked.  

Note: this list may include capitalized forms of common words (such as ‘Trainer’); these are usually better left out 
of the Vocabulary since you can always say “cap” before a word (or capitalize after the fact, thanks to “capitalize 
<xyz>”). However, you may want to add to the vocabulary phrases that contain them, such as Senior Technical 
Trainer. Remember, it’s a good idea to add to the Vocabulary the phrases you usually want capitalized. 

Step 6: Edit items as warranted: if you wish to modify an item (to make it lowercase or expand on it, for instance) or to 
give it a Spoken form, make sure it’s highlighted then click Edit. 

This opens the Edit Word window, which also presents a little context for the item. 
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After you click Next, Dragon gives you the option to provide acoustic training for all the added words. Feel free to 
take this opportunity to pronounce them, but know that you can skip this step and provide later train just the words 
that seem to need it, as explained in this workbook and the Help. 

Finally, Dragon adapts its word-frequency and context information based on the text analyzed (unless you 
unchecked the box “Adapt to writing style” on the first screen); this will allow it to better choose between words 
that sound alike.  

 

Key points about customizing the Vocabulary from documents: 

 You can launch the analysis of specific documents from the Vocabulary menu. 

 This tool can analyze existing documents to learn about the “writing style” you plan to use—meaning, which 
words are used with what frequency, and which words appear near each other. It’s OK to use text written by 
someone else, if it’s similar to what you plan to dictate.  

 To be used in this tool, files must be text files. 

 The tool can process many files at a time. You can re-run it whenever you create or find suitable text. The more 
(relevant) text is analyzed, the more refined your profile becomes.  

 When presented with the unknown words the tool found, you can choose which ones to add. Thanks to the Edit 
button, you can modify their spelling as well as give them a Spoken form if warranted. 

 After adding terms to the Vocabulary, letting Dragon analyze text that contains them helps pre-empt recognition 
errors.  

 Analyzing documents is only one of the ways Dragon can adapt; learn other ways in this workbook and the Help. 
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Customizing the Vocabulary from Your E-Mail  

As you learned, Dragon can adapt its Vocabulary based on designated documents. It also has the ability to quickly learn 
from your usage of e-mail.  

By “studying” the e-mails you sent as well as the recipient names, Dragon can identify potentially useful contact names to 
add to the Vocabulary, as well as adapt its statistical information on word usage (frequency and context). This will help it 
transcribe your dictations more accurately. 

Take advantage of this tool as soon as possible after creating your profile, then every few weeks so that Dragon can 
adapt your profile as your work evolves (for instance, learning the names of new colleagues, customers, or projects). 

 

IMPORTANT: If you want Dragon to analyze Web-based email, make sure your computer is connected to the 

Internet for the duration of the analysis.) 

 

 

Step 1: Say open Accuracy Center, then say click Learn from sent e-mails. 

 

Step 2: The tool displays the names of available e-mail programs (this may take a moment). Check the checkbox of the 
program(s) you want Dragon to analyze. 

Note: If you want to use a Web-based email program that is not listed here, select the box labeled IMAP. You will 
then be asked to enter configuration information including server name and port number.  
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Step 3: Use the checkboxes to indicate whether you want Dragon to only look for names to potentially add to the 
Vocabulary, or whether you also want Dragon to adapt its statistics based on your sent e-mails.  

The option “Improve from my e-mail writing style” will adapt the statistical language model; it is recommended 
except if what you sent contains a language other than the language of your profile. 

Note: When you start this process, your e-mail program may bring up a message asking you to allow access. If 
you have several windows open, this message may be hidden under another window. 

The first time you run this analysis, it may keep Dragon busy for a while. Later on, it will go much faster if you 
choose the option button “Consider e-mail written since my last scan” instead of “Consider all e-mail.” 

Step 4: After its analysis, the tool displays what it identified as potentially useful additions to the vocabulary.  

The rest of the process is similar to the analysis of specific documents: you can check or uncheck items 
individually or all at once, edit items, and train items acoustically if you wish, then Dragon adds to the Vocabulary 
the checked items -- plus it adapts its language model to the “writing style” (word frequencies and word 
sequences observed), if you opted for that. 

 

 

Key points about customizing the Vocabulary from e-mail: 

 Dragon can quickly adapt its Vocabulary from your use of e-mail, including Outlook and Web-based email 
programs. If you want Dragon to analyze Web-based email, make sure your computer is connected to the Internet 
for the duration of the email analysis.  

 Use this as soon as possible after creating a profile, then every few weeks so that Dragon can adapt your profile 
as your work evolves. After the first time, the process will be very quick. 

 This process has two functions: it finds contact names to potentially add, and it analyzes your sent e-mails to 
refine the frequency information in the Vocabulary . 

 When presented with the list of potential additions, you can check or uncheck them all at once. You can also edit 
any item: click the item, click Edit, then modify as needed. 

 Make sure Dragon knows the pronunciations and spelling of your contact names. This is important also for 
shortcut commands for Outlook such as “email the selection to…” and “schedule meeting with…” 
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Starting to Dictate: Controlling the Microphone 

Your microphone must be connected and positioned correctly, and Dragon needs to know whether to “listen.” This lesson 
shows ways to turn Dragon’s microphone or on off and introduces the DragonBar. 

Note: If using a Bluetooth microphone, ensure it is not only powered up but also active (“in call mode”). 

 

The DragonBar and the microphone button  

The DragonBar is Dragon’s toolbar. It includes menus, indicators, and a microphone button to turn Dragon’s microphone 
on and off.  

Note: the microphone button is also in the system tray on the Windows Taskbar. 

 

By default, the DragonBar is collapsed and at the top of the screen; if you move your mouse over it, it expands. 

Be sure to explore the Options dialog and how you can modify the DragonBar, including disabling its auto-sizing.  

If you’re familiar with Dragon and you wish to save space on your screen, set the DragonBar to Tray Icon only. You can 
then access the DragonBar’s content by right-clicking the icon or saying "open Dragon’s tray menu.” 

See the Help for details. Remember: you can quickly launch a Help search by saying a command that ends with your 
search keywords, for example: “search Help for DragonBar display.” 

 

TIP: consider checking that your operating system doesn’t hide Dragon’s tray icon. See the settings for notification icons 

in your Control Panel.  
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Microphone commands and sleep state  

You can turn off Dragon’s microphone by saying the command microphone off. There is no command to turn the 
microphone on because, when the microphone is off, it can't “hear” anything! There are, however, commands to put the 
microphone in and out of a “sleep” state where Dragon doesn’t transcribe your words but it is still listening. To try this, turn 
the microphone on by clicking on its icon, then say stop listening or go to sleep. 

Remember: for all voice commands, have a brief silence before and after, but none in the middle, otherwise Dragon 
can’t recognize the command and instead transcribes the words. For example, make sure you say the command “go to 
sleep” in a natural flow, not “go… to… sleep.”  

Putting the microphone to sleep is useful when you need to put Dragon “on hold" for a moment. However, leaving it in that 
state for a long time is not recommended, so do turn the microphone off if you won’t be dictating for a while and are 
physically able to turn on the microphone manually.  

 

TIP: You can set Dragon to have its microphone asleep when your profile opens, waiting for your command to “wake 

up” so that no manual action is needed to turn the microphone on. To set this option by voice, say “open Dragon options” 
then “click Miscellaneous” then “click Have the microphone on but asleep."  
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The importance of hot keys 

Pressing a key can be quicker than moving and clicking the mouse (and physically easier, too), so software, including 
operating systems, typically contains keyboard shortcuts, also called hot keys. Dragon offers hot keys for various tasks, 
including controlling its listening. 

If your keyboard is full-sized, press the + on the numeric keypad (far right). This turns the microphone on or off. 

 

If your computer doesn’t have a numeric keypad, or you wish to keep the numeric + for other use, change Dragon’s hot 
key. This is done through Dragon’s Options dialog: 

Step 1: Say open options dialog, then say click Hot Keys 
and say click Microphone On/Off. A box opens. 

Step 2: Press the desired key or key combination (F10 is 
often a good choice), then press Enter. 

If the key you pressed is already assigned in another 
application, Dragon lets you know. 

Step 3: Back in the Options dialog, click Apply, then OK. 

 

Note: Dragon also offers a hot key to toggle the microphone between sleep and listening. 

 

 

Key points about controlling whether Dragon “listens” 

 Remember to turn the microphone off (or put it into its sleep state) when you’re not dictating, such as before 
answering the phone or clearing your throat; this is a simple but important habit to develop!  

 Pressing its hot key is usually the fastest way to turn the microphone on and off; you can also click the 
microphone icon on the DragonBar or in the System Tray. You can change hot keys in the Options dialog. 

 You can turn the microphone off by saying the command microphone off, but then the mouse or keyboard need 
to be used to turn it back on. Instead, you could say go to sleep or stop listening and then say wake up or 
listen to me when you wish to dictate again. 

 When saying a command, you must pause slightly before and after but not in the middle of the command.  
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Starting to Dictate: Your First Dictation 

You can use Dragon to dictate into virtually any Windows application. Further in this workbook, you will learn how to start 
programs by voice (but one doesn’t need to have started a program by voice in order to dictate into it.) 

What you dictate will be inserted wherever your insertion point (cursor) is located in your document. There are many ways 
of moving the insertion point by voice, but know that you can also re-position it by hand (clicking the mouse where you 
want it, or using your keyboard’s arrow keys) just as you normally would. 

 

TIP: Before dictating, make sure the desired window is active (its title bar should not be dimmed), and the insertion point 

(vertical bar) is where you want your dictation to appear. (Your operating system can make such visual elements easier to 
see.)  

 

Dictating text and punctuation marks 

Here are the most common punctuation marks, followed by what you say to “voice-type” them:  

. period (or full stop) 

, comma 

? question mark 

!   exclamation point or exclamation mark 

:   colon 

;   semi-colon 

For these exercises, start a word processor (for example, you can say start DragonPad). 

Exercise 1: Look at the following sample, dictate it, then say microphone off. (If any word is misrecognized, ignore it for 
now.) The very first words may take a moment to appear on the screen; this is normal. 

How is this different from dictating to a person? I should try to provide clean input: speaking naturally, but 
without mumbling or trailing off! 

Do turn off your microphone when you finish dictating! If your last sentence reads something like “trailing off! Microphone 
off", you probably forgot to pause briefly before giving the command. (If you cannot use your hands, say “go to sleep” or 
“stop listening” instead of “microphone off.”) 

New line and new paragraph 

With Dragon active, you can press your Enter key but also simply say the command new line or new paragraph.  

Note: When you start dictating your new paragraph, Dragon capitalizes the first letter automatically, like it capitalizes after 
a period, an exclamation point, or a question mark. By default, Dragon doesn’t capitalize after new line or colon. 

 

TIP: If you prefer new line to trigger capitalization, you can change its default via the Vocabulary Editor, since new line 

belongs to a special group of commands accessible there. These so-called Dictation Commands, such as cap, caps on 
and numeral, appear near the top of the list, with a blank Written form. To see them, change the Display drop-down to 
“Word with spoken forms only.”  

Once you’ve highlighted new line, click Properties then choose “capitalized” under “Format the next word.” 

 

The Results Display and its options 
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Exercise 2: Study the following text sample then dictate it in a blank document. (Ignore any errors for now.) 

The more I use it, the software will adapt to the way I sound and the words I use. At the same time, I will also 
acquire good habits like pausing optimally, keeping silent when hesitating, and turning the microphone off, or 
putting it into its sleep state, when necessary! 

As you dictate, a small “rolling” Dragon icon appears, indicating that recognition is in progress.  

If the option “show preliminary results” is enabled (under Appearance in the Options dialog), you will instead see the 
following as in version 10 and prior: 

 Your words first appear in a small horizontal rectangle called the Results Box. Words accumulate in the Results 
Box until you pause, at which point they appear in your document. If many words are dictated without a pause, 
the box automatically stretches out. 

 The contents of the Results Box sometimes change as you speak; what first appears there may not be what is 
inserted in your document, since Dragon sometimes revises its original guess based on subsequent words.  

Dragon uses the everything it hears between two pauses to best choose what exactly it should transcribe; this is 
particularly important for words that can be spelled in different ways, like “to” and “too”. If you speak single words or just a 
few words at a time, the software has few or no contextual clues. For this reason, long continuous “utterances” can be 
recognized more accurately than short ones (and long words better than short ones).  

 

IMPORTANT: Try to formulate your sentences and commands before you start dictating them. This can be 

challenging at first, particularly for those who have been “thinking through their fingers” for years, but you’ll develop the 
habit once you see what a difference it makes. 

Note: Especially if you tend to forget punctuation, or if you are writing informally, consider Dragon’s option to automatically 
insert commas and periods as you dictate (see Auto-Formatting under the Tools menu). The Help contains details about 
this option and the commands to turn it on and off. 

The location and behavior of the Results indicator can be customized from the Options dialog. Many users find it most 
convenient to “anchor” the indicator to a place where it’s unlikely to hide anything, such as the bottom right corner of their 
screen; to do that, just check the “Anchor” checkbox, close the Options dialog, then drag the indicator to the desired 
place. 

 

Exercise 3: Dictate a paragraph of some four sentences on today’s weather. (For now, ignore any errors.) Did you forget 
to dictate punctuation in this paragraph? It can be harder to remember when we are “composing out loud” but, with 
practice, it will become second nature.  

Below are other frequent punctuation marks—you may want to say them out loud once before the next exercise. Note in 
particular the ellipsis and the difference between dash and hyphen.  

Remember: you can use the Vocabulary Editor to see punctuation and symbols with existing spoken forms, as well as add 
your own forms and modify properties (such as “having no preceding space” like the comma.) 

“ open quote 

” close quote 

( open paren or open parenthesis  

) close paren or close parenthesis 

… ellipsis or dot dot dot 

& ampersand or and sign 

--  dash 

- hyphen 
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TIP: You don’t always have to say hyphens: thanks to its built-in Vocabulary, Dragon can automatically include hyphens 

in items such as 3-year-old, above-mentioned, after-tax, ad-libbed, ankle-length, anti-infective, as well as famous 
hyphenated names like Abdul-Jabbar. (To see many, you can choose “Words containing punctuation” in the Vocabulary 
Editor’s dropdown list “Display”.)  

You can prevent Dragon from entering a hyphen by pausing or saying “spacebar” where the hyphen would be. 

 

 

Exercise 4: Dictate the following sample. (If any recognition errors occur, ignore them for now.) 

These lessons remind me that "practice makes perfect." (Who said this, Confucius?)  

When it comes to speech-recognition software, truer words were never spoken… 

 

 

 

Key points for your first dictation: 

 What you dictate is transcribed at the insertion point (the blinking vertical bar), the place where characters would 
appear if you started to type. Before you dictate, make sure that the desired window is not just visible, but also 
has the focus. 

  To modify how Dragon indicates that recognition is in progress, see the Options dialog under Appearance. To 
avoid situations where the Results indicator (icon or box) hides something on your screen, you can "anchor" the 
indicator. You can also change how long the indicator remains on the screen.  

 Speaking in long, continuous phrases provides contextual clues and thus helps Dragon choose between 
homophones like “right” and “write” or “to” and “two”. 

 Punctuation is part of the recognition context. Be sure to dictate at least periods and commas or turn on the 
automatic punctuation option.  

 Two important Dictation Commands are new paragraph and new line. By default, new line doesn’t trigger 
capitalization of the following word; you can change that through the Vocabulary Editor’s Properties dialog. 

 The very first words you dictate may take a moment to appear on the screen. This is normal. 
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Dictating Prices, Units, Dates, Times, Addresses…  

Dragon follows spacing and capitalization rules: for example, it inserts a space after commas but none before, and it 
capitalizes at the beginning of sentences and paragraphs.  

In this lesson, you learn about contextual automatic formatting that allows you to naturally dictate prices, times, dates, 
abbreviations, contractions, units of measure, street addresses, e-mail addresses, URLs, ISO currency codes and other 
special text. You also learn about Spell Mode and other restricted recognition modes. 

 

Automatic text formatting during normal dictation 

On the Auto-Formatting Options dialog, available from the Tools menu, you can turn Dragon’s rules of auto-formatting off 
and on as desired. For example, you can choose the following: 

 Transcribe numbers greater 
than two as numerals. (By 
default, Dragon follows the rule 
that integers under 10 should 
be written as words unless in 
contexts such as a unit or 
address.) 

 Expand contractions (such as 
“won’t” and “didn’t”). 

 Insert two spaces after periods.  

 

 

 

The Vocabulary Editor’s Word Properties dialog offers related capabilities. It lets you obtain contextual format: you can 
ask that numerals always be used after a certain word (as in “version 4”) and you can set alternate written forms (you 
might prefer “figure” to be written “Fig.” before numbers, as in “Fig. 3”).  

Note: it also lets you change the properties of Dictation Commands (for instance, you may wish new line to trigger 
capitalization). Please see Vocabulary Customization. 

Exercise 1: Dictate some phone numbers with and without area code. (No need to say "hyphen".) 
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Please call 607-585-3926 instead of 587-1239.   Toll free directory: 1-800-555-1212  

 

 

TIP: By default, Dragon applies its automatic formatting even if you pause within the segment (the option “Allow pauses 

in formatted phrases” lets you turn this off.) If you need to dictate sequences of 7, 10 or 11 digits and do NOT want them 
formatted as phone numbers, one trick is to say “numeral” just before.  

 

Exercise 2: Dictate the following address. For the line containing the zip code, just say Oakland California 9 1 2 3 5; 
Dragon automatically uses the postal abbreviation for the state and precedes it with a comma. 

127 Evergreen Terrace 

Oakland, CA 91235 

Exercise 3: Dictate the following dates naturally. Say, for instance, “Monday July sixteenth 2009”.  

Monday, July 16, 2009  10/15/16 (say slash)   12-7-2017 (say hyphen) 

 

TIP: You can change the default date format to one of those offered on the Auto-Formatting options dialog. 

 

Exercise 4: Dictate sentences containing prices, including the one here. Dragon includes the currency sign. 

Suggested retail price: $4.90 

Exercise 5: Dictate a sentence containing a URL, such as the following. Dragon omits spaces in URLs.  

Please visit www.thebestbusiness.com for more information. 

Exercise 6: Dictate the following e-mail addresses. (Remember: for e-mail addresses you often dictate, adding them to 
your vocabulary ensures that you can dictate them quickly and accurately.)  

Laura_Miller@domain.com (say “Laura underscore Miller” and “at” or “at sign”) 

customerservice@electricalexperts.com (“customer service at electrical experts dot com”) 

The restricted recognition modes 

There may be times when you want Dragon to recognize less than it normally does. You may want to speak only 
commands, or enter many numbers or characters in a row—when inputting figures or product codes into a database, for 
instance.  

Take a moment to explore Dragon’s restricted recognition modes, which include Numbers Mode, Spell Mode, Command 
Mode and Dictation Mode. (Please see the Help for details beyond the ones below.) Note: Dragon includes a persistent 
indication of the current recognition mode on the DragonBar (next to the Full Text Control checkmark). 

 

TIP Dictation Mode can be helpful if you want to dictate as quickly as possible. 

 

http://www.thebestinthebusiness.com/
mailto:Laura_Miller@domain.com
mailto:customerservice@electricalexperts.com
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Numbers Mode  

When about to dictate a lot of numeric data, consider switching to Numbers Mode. When in this mode, the software tries 
to recognize everything it hears as number-related (or as a command). 

Step 1: Say numbers mode on or choose Numbers Mode from the DragonBar.  

Now that Dragon is in Numbers mode, you can: 

 dictate numbers and punctuation (hyphen, dollar sign…). For decimal point, say dot or point. 

 say new line, new paragraph and space  

 say go up|down|left|right <n> to move the focus to another line, cell, or item. 

Step 2: To resume regular use, say a command such as switch to normal mode or use the DragonBar. 

Spell Mode  

The Spell Mode is useful for dictating character sequences which don’t form pronounceable words, as is often the case for 
part numbers, license plate numbers, codes, usernames and passwords… It’s also useful for spelling out terms which you 
anticipate Dragon won’t know, such as words in a foreign language or unusual product names. Of course, if you plan to 
use these words or phrases more than once, you should add them to the Vocabulary, with spoken form if warranted. 

Step 1: Say Spell Mode on or Switch to Spell Mode. The DragonBar will indicate that Spell Mode is on. 

You can now dictate characters, including letters, digits, and symbols, as well as spacebar.  

 To capitalize a letter, say cap immediately followed by the letter. 

 As in Numbers Mode, you can use the move <direction> <number> commands to navigate. You can also say 
space. (Dragon won’t automatically handle spacing as it usually does.)  

 You cannot use new line or new paragraph, but you can say press Enter. 

Step 2: You can return to normal dictating by voice (Spell Mode off…) or by hand (Modes menu> Normal Mode). 

 

TIP: The Vocabulary Editor and the Help contains the list of possible pronunciations, including the alpha-bravo-charlie 

alphabet and accented characters like “n tilde” and “alpha umlaut”. You can say “oh” instead of “zero”. 

 

The Spell Command: characters within Normal Mode 

If you need to dictate a sequence of characters in the middle of normal dictation, the Spell command is usually faster than 
switching in and out of Spell mode: while in Normal Mode, you can say “spell” immediately followed by a sequence of 
characters (digits, letters, symbols, and space or spacebar). See the Help for details. 

This can also be useful in cases where you want to put on the screen a word that would normally be interpreted as a 
symbol or a command. For instance, if you wanted to be sure that Dragon types the word “comma” instead of the 
character comma, you could say “spell space C O M M A”. This is also useful for the word “cap” which is also a Dictation 
Command (to trigger capitalization of the following word): say “spell space C A P.” 

 

Exercise 7: Dictate “access code: 75Zq/7”, then practice with character sequences of your choice. (Pause briefly after the 
colon, then say “spell 7 5 cap zee cue slash 7”. Try to not pause at all during the sequence; if you paused, just resume 
by saying “spell” immediately followed by the rest of your sequence.)  
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Key points about dictating numbers and special text 

 Dragon can automatically format dates, prices, addresses, units, and other special text. The Auto-Formatting 
dialog lets you turn format options off or on, and the Word Properties dialog lets you adjust spacing, 
abbreviations, and alternate forms such as “travelled” and “traveled” but you can also just let Dragon reach out to 
you through its Smart Format Rules box when you make an edit that might warrant adjusting one of its format 
settings.  

 The restricted recognition modes can make dictating special text more efficient. They are accessible by 
commands (“Numbers Mode on”, “switch to Normal Mode”) and through the DragonBar.  

 To dictate as quickly as possible, consider Dictation Mode. 

 Before dictating only numbers and punctuation, consider Numbers Mode. 

 Before dictating a long sequence of characters (letters, digits, punctuation, symbols), consider Spell Mode. The 
spell command is good for sequences you can say all at once, such as “spell space T W O”. 

 When spelling, you can use alternate pronunciations such as alpha, bravo, etc. and insert a capital by saying cap 
just before the letter. You can also say space or spacebar.  
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Correcting Dragon’s Errors in Your Dictated Text 

Humans sometimes can’t recognize words correctly—especially if the speaker and the listener come from different places, 
if the topic is unfamiliar, or if the speaker don’t enunciate clearly enough. In addition, when we hear a word for the first 
time, we may not know how to spell it; some names can be spelled different ways, like Gene/Jean and Hansen/Hanson.  

Dragon has similar challenges: it uses contextual clues and statistical information to guess what to transcribe, but 
sometimes can’t guess correctly. It may not recognize uncommon words on the first try and instead types something that 
was likely according to its statistical model. It can’t transcribe a word it has never seen. Fortunately, in addition to 
optimizing acoustic factors, customizing the vocabulary and correcting errors significantly reduces errors.  

You can choose when to perform corrections. If you look at your screen while dictating and notice that Dragon got a word 
wrong, finish your train of thought before you correct that.  

 

Handling multiple matches in your text 

When you give a command for a specific word or phrase in your text, such as commands starting with correct, delete, 
bold and capitalize, we suggest providing context by including at least the preceding or following word: for instance, to 
correct "a" in the phrase "Alex sent a request," say “correct sent a” or "correct sent a request." 

If Dragon does find several matches, it places a number next to each match. You then say the number of your choice or, if 
you wish to affect all instances at once, say choose all. (If you want the numbers to disappear, say cancel, click your 
mouse, or just keep dictating.)  

Note: 

 Saying undo that undoes the change for just the last instance. To undo the change to all, say undo all. 

 Choose all can’t work for “select” or “insert before/after” commands. If you wish to replace several instances, 
consider your application’s options for replacing, including case-match. 
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TIP: When you give the ‘correct <xyz>’ command, say what is on the screen, not what you had intended (<xyz> 

represents the relevant segment on the screen, which could be more than one word and include punctuation).  

 

The Correction Menu: the default interface 

By default, when you say a command starting with the word "correct,” Dragon brings up the Correction Menu, listing 
alternative transcriptions and some commands you may wish to say, including playback and capitalization.  

 If what you had said is in the list, 
pick it by voice (say choose and 
its number) or by hand (click your 
choice or use the down arrow and 
Enter key). 

 

 If it isn’t, click or say spell that 
which opens the Spelling 
Window—there, you can give the 
correct transcription by voice, hand 
or a combination. 

 

 

Note that the bottom of the Correction Menu gives direct access to the Options dialog’s Correction section. One setting 
you can modify there is whether Dragon opens the Correction Menu when you use a command like select that. Some of 
the other settings have to do with the Spelling Window. 

Correcting in the Spelling Window 

Some users prefer the Spelling Window to be the default interface for correction so that, when Dragon’s list doesn’t show 
their choice, they can act directly instead of having to use “spell that” from the Correction Menu to get to the Spelling 
Window.  

This requires changing one of the Correction options. Here is one way to do this: say open Dragon options then say 
click Correct commands bring up Spelling Window . 

With this option set, saying commands that start with “correct” opens the Spelling Window, and so does pressing the 
Correction hot key (the numeric minus by default) or using the Correction button on the Classic DragonBar.  
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As you will see, there are many ways to indicate in the Spelling Window what should have been recognized—
including typing or spelling out individual characters, hence the name “Spelling Window.” 

Below is an example. Imagine you wanted "Madyssen" (an uncommon name) but Dragon wrote “medicine” (a word 
commonly used in English) instead.  

To correct Dragon’s error, you say “correct medicine.”  

The Spelling Window then opens. 
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At its top is what was transcribed, and below is a list of 
alternate transcriptions, each preceded by a number.  

What you can do: 

  

If what Dragon should have written is listed: 

 say choose n (the number of the correct line—
you can also pick by double-clicking or using 
the down arrow and Enter key). 

 

 

If no choice is correct but one is close:  

 save time by modifying that choice: click it or 
say edit n (here you could say “edit 1” then 
“backspace 4” and “Y  S  S  E  N”).  

 

 

If what Dragon should have written isn’t listed: 

 enter it then say click OK or press Enter (here 
you could say “cap M  A  D  Y  S  S  E  N”). 

 

 

 

The Spelling Window then closes and, in your text, Dragon replaces the misrecognized segment with what you indicated 
was the correct transcription.  

Note: In addition to adjusting your document, Dragon learned a bit of information to refine your profile, and if you entered 
in the Spelling Window a word that wasn’t in its active vocabulary, Dragon has now added that word to its active 
vocabulary (you could now see that word in the Vocabulary Editor). 

Remember that Dragon allows the use of voice but doesn’t prohibit manual action; at different times one may be quicker 
or easier than the other. In the edit line of the Spelling Window, it can be faster to make modifications with mouse or 
keyboard, but you can perform correction entirely by voice.  

You cannot dictate words in the Spelling Window. However, you can dictate:  

 Individual characters: letters, digits, space, symbols (see your documentation for details) 

 Commands like “backspace 5”, “move right 4 characters”, “delete next word”, “select line” 

Note: In the Spelling Window, Backspace and Delete commands should be used instead of scratch that, 
especially if Press Key commands are used. 

 

As you enter characters in the window, Dragon presents new choices in the list so you may not have to enter all 
characters! Here are tips for spelling out: 

 To spell a capital letter, just say cap followed by the letter. 

 You can use alternate pronunciations to spell letters: alpha, letter alpha, letter a, bravo, charlie, delta, echo, 
foxtrot, etc. (see the Help for the full list) 

 To insert a space, say space or spacebar. 

 

Note: If one of the choices listed is close, you can save time by modifying it: say edit and its number, which brings 
it to the window’s edit line. 
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Exercise 1: Look at the following sample, dictate it, then use the correct <xyz> command to fix any errors. (This sample 
was designed to create errors! All the names here could be spelled in different ways.)  

Until further notice, the BHDP meeting will be held in room B31 (not B40).  

Special invitees this week: Stephen Hess, Anne Petersen, and Gene Wood. 

 

TIP: If several consecutive words are incorrect, correct them together. For instance, if "B40” were recognized as "before 

tea,” you would say correct before tea. 

 

 

Exercise 2: Dictate a few sentences containing uncommon words, such as names and nicknames or product names, until 
a few misrecognitions appear. For each misrecognition, bring up the Spelling Window and practice spelling out what you 
actually said, as well as editing one of the choices from the list. 

Using playback to aid correction 

Sometimes, especially if you dictate a lot before correcting, you may not remember exactly what you actually said. This is 
one of the uses of Dragon’s playback feature, which you can take advantage in several ways. 

If you see that a certain word or phrase appears incorrectly, use the correct command to open the Spelling Window. 
Once it appears, click or say Play Back to hear the recording of your voice as you dictated that text. It may be that in fact 
you had misspoken or mumbled; this happens to everyone, particularly near the end of the day! In that case, close the 
Spelling Window (you can say click cancel) and dictate the word(s) again. 

 

TIP: You can have playback occur automatically with Correction. In the Options dialog, check Automatic Playback on 

Correction. This is particularly helpful as you first learn to use Dragon; you may want to turn it off after a few weeks of 
practice. 

 

You can also use Playback to hear sections of dictation in the document itself. To do this, select the editable text you 
would like to hear played back. Then, say play that back, or use the DragonBar’s Audio menu. If you find a 
misrecognition, you can stop playback by clicking the mouse (or using the Correction hotkey or button -- see below). 
Because speech input cannot be received during playback, you cannot stop playback by voice. If clicking the mouse is 
problematic for you, play small selections at a time. 

Note: You may wish to explore the Playback attributes in the Options dialog. 

If using the Classic DragonBar, expanding it (click its chevron or say view extras bar) gives access to extras:  

 

 The Correction button opens the correction interface (as do the Correction commands and hot key).  

 The playback icons, similar to those on a music player, allow you to begin playback, speed up (useful for large 
sections of text) or stop playback, and skip backwards or forward. 

 The Transcribe button launches the transcription of recorded dictations (for details, see the Help including the 
Auto-Transcribe Folder Agent). 



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 37 

 

Exercise 3: Dictate a detailed paragraph about people you know. Then select it and play it back. If you find any 
misrecognitions, use the Correction button, hot key, or commands to correct them.  

Note: As you use Dragon more, experiment with how to correct and when to correct. (We recommend finishing at least 
your current paragraph before making a correction, so that you preserve your train of thought.) Notice what seems more 
convenient and efficient for you. 

Smart Format Rules 

When you make an edit related to formatting, such as abbreviations, titles, units of measure, or alternate forms, Dragon 
may display its Smart Format Rules box, offering to change one of its Auto-Formatting options or Word Properties 
settings. You can then either accept one of the adjustments offered, or dismiss the box. 

If you wish, you can change settings in the Auto-Formatting Options dialog box or the Vocabulary Editor. The Smart 
Format Rules feature simply "reaches out" to you, making it quick and easy to have the settings you want. 

For example, when you dictate “five kilograms,” Dragon writes “5 kg” and if you then change “kilograms” to “kg” (by 
overtyping or with the Correction menu or Spelling window) Dragon presents the following box. 

 

See what Smart Format Rules box offers and, if you want one of its proposed adjustments to be made, say “choose” 
followed by the desired number.  

If you don’t want any of the adjustments listed, say “cancel” or just move on to whatever you’d have done if the box hadn’t 
opened. 

 

 

Key points about correcting recognition errors 

 Refining your profile can prevent many errors. Add words and phrases to the Vocabulary, with Spoken forms 
and/or Properties if warranted, and let Dragon see them in context by analyzing relevant text. 

 Though correcting misrecognitions may at first seem time-consuming, it increases accuracy, thereby saving time 
because there will be fewer and fewer misrecognitions to address.  

 Don’t pause between ‘correct’ and the erroneous word or phrase. Consider “rehearsing” in your head. 

 To be sure of what was said, use Playback. This also gives you feedback on how clearly you dictated. 

 You have the option to set the Spelling Window as your default correction interface.  

 In the Spelling Window, you can say choose n to pick from its list, and if a choice is close, you can quickly modify 
it. You can to type or spell out words, but not to dictate words directly. 

 

../AppData/Users/Gabbay_Delphine/AppData/Roaming/Microsoft/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/Content.Outlook/2P4P3JSU/work/p4doc/main/doc/main/enx/Content/user_voc/voc_editor_dialog.htm
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Editing Text by Voice 

Dragon lets you use your voice to move within a document and edit its contents whether or not that document was 
originally created by voice.  

This lesson presents many editing commands. Mouse and keyboard can still be used! At first, focus on getting optimal 
accuracy in dictation: speak clearly, adapt the vocabulary, correct as needed, etc. 

 

Navigation and selection  

Below is a just sample of commands. Remember that you can always open commands for formatting, navigation, and 
correction by saying what can I say.  

Note: in all commands, the words go and move are interchangeable, and a space counts as one character. 

 

Some commands move the insertion point regardless of its starting location: 

 go to top –- moves to the beginning of the document 

 go to bottom –- moves to the end of the document 

 

Other commands move the insertion point relative to its present location: 

         go to end of line (the current line, the one containing the insertion point) 

 go up(down) 1-20 line(s) or paragraph(s) –- e.g. go up 3 lines  

 go left(back) 1-20 word(s) or character(s) –- e.g. go left 7 words 

 go right(forward) 1-20 word(s) or character(s) –- e.g. go forward 3 characters 

 

To place the insertion point at a specific word or punctuation mark in the text: 

insert before your office –- moves the insertion point to just before the phrase "your office" 

insert after Joe comma -– moves to just after the comma following the word “Joe” 

 

The select commands let you designate editable text visible on the screen. Say select and a word or phrase on the 
screen including punctuation as needed:   

select comma obviously comma  

 For longer phrases, name the range’s start and end in your command: 

 select do let through please in "do let me know at your earliest convenience please" 

To select the entire field or document: select all 

To select by characters, words, lines or paragraphs:  

select line, select next 3 paragraphs, select previous 5 words as well as select rest of line  

Note: similarly, you have delete line, delete next 3 words, etc. and copy rest of line, etc. 

To “unselect,” say unselect that or move the insertion point (say go to end, for instance).  
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TIP: For commands that quote words from your screen, choose your target words before you start to speak. 

Any hesitation will cause the words of the command to be typed on the screen. If this happens, just say undo that 
and give your command again, this time in one flow. 

 

Context helps recognition, so always strive to dictate in complete phrases. When it comes to commands, speaking in one 
flow isn’t just helpful, it’s essential. The Interactive Tutorial and this workbook offer you practice. 

  

Direct editing: Bold | Underline | Capitalize | Copy | Delete | Cut…  

Dragon lets you perform frequent editing tasks quickly: like you can quote from editable text in the commands select 
<xyz> and select <start> thru <end>, you can say the verbs bold, underline, italicize as well as capitalize, 
immediately followed by the desired word(s).  

This also applies to copy, as well as delete and cut. Note that these three can be disabled, as explained below. 
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TIP: If these commands are enabled, Dragon tries to recognize as one of them any phrase starting with one of these 

verbs followed by a word or phrase present in the text: e.g. “bold measures” or “cut corners.” This could happen if the 
phrase is said in isolation—for instance, if the speaker is creating a list or hesitating (as one often does when composing 
out loud). If this happens, say undo that. 

Think in particular of the possibility of cut <xyz> and delete <xyz> being recognized, especially if you dictate without 
looking at the screen. You can disable or enable these commands in the Options dialog. 

 

Handling multiple matches in text  

When you give a command such as “correct <xyz>,” “insert before <xyz>” or “bold <xyz>” and there are multiple matches 
for what you said, Dragon lets you resolve that ambiguity and even take advantage of it.  

A number appears next to each visible match. You can then: 

 say the number of your chosen instance, or  

 say “choose all” (for commands that can apply it)  

 

 

Full Text Control, “unknown” text fields and the Dictation Box 

Commands that quote specific words in your text work thanks to a functionality called Full Text Control or enhanced 
dictation and editing (formerly “Select-and-Say”). 

This functionality requires the text field to let Dragon be aware of its contents, such as the boundaries of words and 
sentences. It includes Dragon’s ability to automatically capitalize the first word, adjust spacing after an insertion, and play 
back dictation. 

Many popular applications build their text fields (or at least most of their fields) in a standard way, and as a result Dragon 
has Full Text Control in these fields. However, you may encounter a field for which Dragon can’t have that awareness and 
therefore can’t apply all its capabilities. PowerPoint slides are one example; Word Online is another.  

When the insertion point is in an “unknown” field, the DragonBar’s Full Text Control indicator is dimmed. If you just dictate 
a flow of words, you may not notice anything unusual in your text, especially if you start with a word that is always 
capitalized such as a name or the pronoun “I”.  

Even in “unknown” fields, one can use Dragon efficiently—knowing the following: 

1. To dictate short entries, you may want to just use what works in all text fields: 

 say ‘spacebar’  

 say ‘cap’ before a word to force its capitalization  

 say generic commands like select line, undo that, go to top and move up 3 

 complement voice input with manual actions. 
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2. To dictate or edit something substantial, consider the Dictation Box, an intermediary window with Full Text 
Control. When your content is ready, say ‘click transfer’: Dragon transfers it to where the insertion point was 
before the box opened. 

 

By default, the box opens automatically if you speak where Dragon doesn’t have Full Text Control (except in Web 
browsers); this can be changed in the Options dialog, under Miscellaneous. 

To open the Dictation Box yourself, you can use a command (open Dictation Box), a hot key (Ctrl+Shift+d) or 
the Tools menu. 

There is a lot of flexibility around the Dictation Box. You can: 

 Change its hot key  

 Give its command one or more alternate names, if you prefer to open it by saying ‘open Dragon box’ for 
instance (to find the command in the Command Browser, pick Global Commands in the Context list and 
the word ‘box’ in the Filter) 

 Modify its appearance and behavior: default font size, positioning (anchored or near the cursor), copy and 
paste method, whether it shows how many characters it contains… 

 Have different settings for different applications. See the Help for details. 
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Replacing and inserting  

The select and correct commands are useful when you wish to change some of the text on your screen. As you would 
with mouse or keyboard, you select the relevant segment then you overwrite it by dictating or typing.  

For instance, if your text reads "100 Main Street" but you wish to change it to "500 Washington Street", say select 100 
Main (pause) 500 Washington.  

 

TIP: For larger passages, save time by using select line, select <start> through <end>, select paragraph… Note 

also that the command “resume with…” can be very efficient as an equivalent of selecting what you just dictated up to a 
particular word then deleting that segment and resuming dictation; read about it in the Help and try it out. 

 

Exercise 1: Practice “overwriting” by voice. Examine then dictate the following paragraph. 

I will be in the Boston area for a few days the week after next, and would love to get together for lunch. We 
could meet at your office at noon. I’ll be staying at the Madison downtown.  

1) Say select lunch  The word “lunch” is now selected. 

Say an early dinner  The sentence should now read “get together for an early dinner.” 

2) Say select noon then six o’clock  “We could meet at your office at 6:00.” 

3) Say select in through next  “in the Boston area for a few days the week after next” is selected. 

Say in your area on Tuesday July fifteenth  
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4) Notice the insertion point’s position. Say insert after dinner, then say if you have time. 

 

TIP: If, after doing some editing in your text, you need to remove extra punctuation or spaces, you can use commands 

such as backspace or delete next character. You can even say backspace combined with a number: for example, 
backspace 5 is like pressing the backspace key 5 times. 

 

Dragon can help you quickly edit text whether or not this text was created by voice. The exercise below is to be performed 
by voice, but remember that day-to-day you may use a combination of voice and keyboard/mouse. 

Exercise 2: Look at the following, dictate it, then edit it by voice as described below.  

Dear Ms. Cooper, 

It was nice meeting you Tuesday. I think you have some good ideas about the Johnson project! I could get my team 
focused on this project by February.  

When you have time, could you write up your comments and email them to me? I would really appreciate it. 

 Edit the first sentence so it reads "meeting with you yesterday". 

 Edit the second sentence so it reads "You have some great ideas". 

 Edit the third sentence so it reads "on this important project" then insert a blank line after it. 

 Change the question to “Could you email me your notes please?” 

 Change "Ms. Cooper" to "Allison." Remove "really" and add "Sincerely, Debra Peet-Smith". 

Which commands did you find most useful in each situation? 

 

 

Key points about editing text 

 You can edit text by voice even if that text wasn’t created by voice. Dragon’s many editing commands can 
address small or large segments, even the entire document. At any time, say what can I say. 

 Uttering the whole command can be tricky for commands such as select <start> through <end> and insert 
before <xyz>. Deciding what to say before starting to speak is always advised!  

 For deleting all the way back from what you just said to a certain word and resuming dictation, the command 
resume with… can be very efficient; we recommend it. 

 Commands that quote text (bold <xyz>, correct <xyz>, capitalize <xyz>, etc.) work thanks to a functionality 
called Full Text Control, which depends on Dragon’s ability to keep concordance between text and audio, so for 
instance Dragon can adjust spacing and capitalize the beginning of a sentence.  

 In a non-standard field, you can say cap to start a sentence and space to create a space, or use the Dictation 
Box—an intermediary window which has Full Text Control.  

 You can modify the Dictation Box’s appearance, behavior and hot key, and choose a different phrase to open it. 
In Dragon 15, the Dictation Box opens automatically where Dragon doesn’t have Full Text Control except in Web 
browsers. You can disable or enable the automatic opening per application.  
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Formatting Text by Voice 

Whether text was originally dictated or typed, Dragon lets you use your voice to control font (Arial, Courier…), font style 
(bold, underline…), font size, alignment, color, and more. 

Note: In order to preserve your train of thought, it’s a good idea to prioritize dictation over formatting: first dictate your 
document (or at least finish dictating your paragraph, list, or idea), then revise your words if needed, and only then apply 
formatting. 

 

The "X that" convention 

Dragon has many commands to tell the computer to perform a certain action on a certain item. Many are phrased as "X 
that", with X being a verb for the desired action: for instance, italicize that and delete that. 

Remember, for commands to be recognized, you must pause before and after the command but not within it.  

When Dragon hears an "X that" command, it decides what “that” is as follows: 

1) If anything on the screen is highlighted (whether by voice or by hand), Dragon performs the action on that 
selection. (It can be one or more characters or words.) 

2) If nothing is highlighted, Dragon performs the action on whatever you dictated since you last paused—in n other 
words, the contents of the Results box, the last utterance. 

Note: In commands, you can say “the selection” instead of “that”—as well as “it” or “this.” 

Dragon's "X that" commands include: 

cap that – capitalizes the first letter, e.g. Water Management (see also “capitalize <xyz>”) 

all caps that – capitalizes all letters, e.g. EXTREMELY IMPORTANT 

no caps that – puts in lowercase all words, e.g. american express 

bold that, italicize that, underline that (Dragon also has “<verb> <xyz>”) 

restore that – removes all bold/italics/underline formatting from the segment 

left-align that, right-align that, center that, justify that  

copy that and cut that (see also the direct editing commands “<verb> <xyz>”) 

paste that 

hyphenate that – puts hyphens in the spaces within the segment  

compound that – removes spaces between words in the segment 

bullet/unbullet /number that 

quote that – puts quotation marks around the segment  

bracket that (inserts rounded characters instead of square ones if your profile is set to UK English) 

empty quotes /brackets –inserts a pair of quotation marks or brackets so you can dictate between them. 
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TIP: The Command Browser’s Keyword Filter lets you explore additional command wordings for the applications you 

frequently use, as seen in this screenshot. For instance, in Word and WordPerfect, you can say “turn bullets on” and 
“turn bullets off” as well as “format that bulleted and bold.” 

 

The "Format That" commands 

Not all formatting commands are worded as "X that", but all follow the same rules about what text the action is performed 
on: the selection if there is one, otherwise the last utterance (what was said since the last pause.) 

As seen in the Command Browser, the many formatting commands include: 

format that bullet style (also: bullet that or make that bullet style) 

format that numbered 

format that centered 

format that strikeout –- places a line through the selection (for example, January 19) 

format that regular 

Note that formatting commands can combine several indications, as in: 

format that Garamond, format that Arial 13, etc. –- gives the selection the font name/size specified 

format that 20 point, format that 13 point, etc. –- gives the selection to the point size specified 
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format that bold italics  

format that caps bold 

format that bulleted and plain 

 

Exercise: Dictate the following to experiment with giving format commands as you dictate and afterwards.  

I FINALLY read The Grapes of Wrath. Although it is long, I read it surprisingly quickly. 

 

TIP To undo the last action, say undo that. This is equivalent to the keyboard shortcut Ctrl z. 

 

 

Key points about formatting documents 

 The “X that” commands apply to the current selection or, if there is no selection, to the last utterance (what 
Dragon heard since you last paused).  

 Remember to pause briefly before and after saying a command. 

 To undo the last action, you can say undo that (which is equivalent to press control z).  

 For efficiency, prioritize dictation over formatting: first finish capturing your thought, then revise or correct the text 
if needed, and only then apply formatting. 

 Formatting commands can include several indications, such as bolding and bulleting. 

 



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 47 

 

Controlling the Operating System and Applications  

Dragon can do much more than type and format your dictated text: it lets you use your voice to find information, open a 
specific website, start programs, open desktop items, switch between windows, maximize windows, choose menu items, 
navigate dialog boxes, click buttons, press keys, move or drag the mouse pointer, etc.  

 

IMPORTANT: When Dragon is running, it doesn’t inhibit the use of your mouse and keyboard. Mouse, keyboard, 

and voice are three input options; use whatever is fastest and easiest for you for a given task. 

 

Searching the computer  

Dragon has shortcut commands to speed up a process many of us go through often: finding information that is 
somewhere on our computer!  

At any time, no matter what application is currently active on your screen, these commands let you launch a search for 
items containing the keyword(s) you specify.  

They have flexible wordings (the Command Browser lets you see all the possible ways to say them) and can be general 
or specific, as follows: 

• search computer for <xyz>, <xyz> being any word or words  

• search emails for <xyz>: searches just the e-mails indexed on your computer 

• search documents for <xyz>: searches just the indexed files 

• search history for <xyz>: searches just the indexed Web pages visited 

Note: The Desktop search shortcuts can be disabled or enabled in the Options dialog, where the box “Enable Desktop 
search shortcuts” also controls the Help search shortcut (search Help for…). 

 

Controlling programs and windows 
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You can use your voice to open any item present on the Desktop, including files, folders, and shortcuts: just say open 
followed by the item’s name. (You can also use the verbs start, launch or show.) For instance, to open an item called 
“winter projects”, you could say open winter projects. (It’s helpful to use names that are easy to speak!)  

This works at any time, even if the desktop is not visible. This is a powerful feature but if you don’t need it, consider 
disabling it; see under Commands in the Options dialog. 

Dragon has a similar option for Start items: at any time, you can start by name any program or item present in the Start 
menu, saying open Internet Explorer or open Control Panel. Consider disabling this powerful feature if you don’t need 
it.  

 

TIP: Do you need to say "start Word", "start Microsoft Word" or "start Microsoft Office Word 2013"? Under Start, look in 

Programs; the name listed there is what you usually want but shorter names are supported for popular applications, and if 
desired you can create a shortcut to the application and give that shortcut the name you want. 

 

To open the Start menu, say click Start or click Start menu.  

To close the active window, say close window or press F4. 

Resizing and switching  

To minimize the window in focus, say minimize window. To maximize, say maximize window. 

If several windows are open, you can change which one is active and in the foreground in several ways: 

 Say “switch to” followed immediately by the name of the desired application, folder, or document: switch to 
Outlook, switch to Computer, switch to DragonBar, switch to winter projects. 

 Say switch to next window to cycle through the open windows (this is equivalent to Alt Tab). 

 Say list all windows then say (or press) the number of the desired window. Note: you may wish to specify an 
application, saying for instance list windows for Dragon or list windows for Firefox. 
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“Clicking” menus, buttons and other controls 

To "click" on an application menu, just say its label preceded by the word “click” (or not—see below). For instance, for a 
menu labeled Insert, say click Insert. (The application must have the focus, which you can usually tell by the appearance 
of its title bar.)  

When accessing a submenu, pause briefly after the name of the menu. For instance, to save a file under a certain name, 
you could say click File, then say save as. 

 

TIP: To close an open menu, you can just say cancel or press Escape (equivalent to pressing the Esc key at the top 

left of your keyboard). 

 

Note: With Office 2010, Microsoft introduced changes to the application interface—in particular, the File tab. For this tab, 
you must say “file tab” not just “file.” With Office 2013, Microsoft also made some interface modifications. For details, see 
the Help. (Remember that you can quickly launch a search in Dragon’s Help by naming search keywords in a command 
such as “search help for office 2013.”) 

In addition to menus, program interfaces may contain controls such as buttons, checkboxes, and radio buttons. How do 
you access these by voice? You guessed it: “say what you see” preceded by “click” if required. Please note: 

 Dragon lets you require the word “click” before the names of menus independently from buttons and other interface 
controls. 

 By default, Dragon requires the word ‘click’ before the name of menus as well as buttons and other controls: for 
instance, for a button labeled OK, you would say click OK. (This can be useful to prevent unintended actions such as 
the clicking of Send in email.) Dragon offers a similar “Require ‘Click’” option for HTML links, which applies to links in 
supported Web browsers, Help, and Accuracy Center. See the Commands page of the Options dialog. 

This workbook presents several of Dragon’s dialog boxes, which often contain controls labeled Cancel, Yes, or OK. As 
you perform the exercises in each chapter, consider practicing clicking controls by voice.  

Exercise 1: Previous lessons introduced you to the Options dialog; we will use this dialog box to practice accessing 
buttons, tabs, and other interface controls. 

1. Open Dragon’s Options dialog, then its Appearance page.  

2. Select and unselect the radio buttons and checkboxes for the DragonBar. 

3. Restore the defaults. 

 

IMPORTANT: Dragon lets you disable its ability to “track” the name of interface controls, in all programs or just in 

programs of your choice: see the checkbox and drop-down list “Voice-enable menus, buttons and other controls” on in the 
Options dialog under Miscellaneous. 

 

Natural Language Commands and the Command Browser 

Dragon comes with large sets of commands that let you order actions naturally and directly, instead of going through 
menus and dialog boxes: for instance, saying “insert page break” in Microsoft Word instead of opening the Insert menu 
then choosing Page Break. 

Command names typically describe the desired action, starting with the verb.  
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 To read about the commands for a specific application, say open help or launch a Help search on keywords with 
a command such as “search Help for Firefox commands.”  

 To see all commands and their variations (optional words, alternate words, etc.), use the Command Browser’s 
Context list and Keyword Filter to display just those that contain a particular word and apply to a particular 
application. When you see one that looks interesting, ensure it’s highlighted then use the Command Browser’s 
menu to see all its wordings (for instance, to expand ellipses). 

 

IMPORTANT: If it detected that your PC’s resources would not allow it to perform with both maximum speed and 

accuracy, Dragon may have disabled its Natural Language Command sets for Word, Excel, PowerPoint and WordPerfect. 
If speed is not a priority for you and you wish to use Natural Language Commands in one or all of these applications, 
enable them via the Option dialog. 

Note that if you enable the Natural Language Commands for Word, for instance, Dragon’s speed may decrease within 
Word. 

 

“Voice-pressing” keys 

At times, you may wish to use your voice to press a key or key combination on your keyboard. 

Common accelerator keys for Windows operating systems include: Esc to close a window, Enter to active the item which 
has the focus, Tab to move the focus forward, and Shift Tab to move the focus backward. Most buttons, menus and 
checkboxes have an underlined letter in their label: you can activate them by pressing the underlined letter (if underlines 
are not visible, press Alt first.) For keyboard shortcuts specific to a particular application, search the application’s Help or 
the Internet. 

Dragon lets you “voice-type” keys on your keyboard. Just say press or type followed by the name of the key(s): a letter or 
number, or Page Up, Home, Enter, Tab, Caps Lock, F2, Control, Alt, Shift, Windows, etc. For instance: 

Say press spacebar    to select or unselect a checkbox. 

Say press F5     to refresh the view. 

Say press Alt e    to “click” a control labeled with an underlined ‘e’. 

Say press Control f    to open the Find field in most applications. 

Say press Escape    to “escape” out of a window. 

Say press Alt Down    to open a drop-down list. 

Say press Windows D   to show the desktop. 

Note: To undo a keystroke, you can say undo that. 

Exercise 2: Observe the Find and Replace box below and its controls: tabs, drop-down lists, checkboxes, and buttons. 
Answer the following (think of “voice-typing” as well as “voice-clicking” options), then open a similar box in your 
word processor and practice navigating it by voice.  

 How could you place the insertion point in the Find field? How could you go to the other tabs? 

 Which control currently has the focus? How could you move the focus to the Find Next button? 

 How could you close this dialog box? 

mk:@MSITStore:C:/PROGRA~1/Nuance/NATURA~2/help/enx/power/dragon_enx.chm::/cmd_browser/open_command_browser.htm
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Remarks for Windows 8 and 10 

With Windows 8, Microsoft introduced major changes compared to previous operating systems while also offering an 
interface similar to the “classic” Desktop. Functionality equivalent to the Start menu is provided by the Charms bar and the 
Start screen. You can use the commands “open Charms bar” and “open Start screen.” (To see the expanded view of 
the Start screen, you can say “show all applications.”) You can also take advantage of Dragon’s ability to press keys. 
For example, say “press Windows key.”  

For the latest on using Dragon with a particular operating system, please see the Knowledgebase at 
www.nuance.com/support/dragon-naturallyspeaking. 

 

Key points about controlling your computer by voice 

 At any time, no matter what is visible, you can open a Start or Desktop item by saying open followed by the name of 
the item. These two powerful capabilities can each be disabled or enabled from the Options dialog. 

 You can switch between open windows with commands like switch to Firefox and list windows for Dragon. 

 To click links, menus, buttons, and other controls, you can “say what you see.” By default, Dragon requires ‘click’ 
before the item’s label: for an “OK” button, say click OK.  

 You can “voice-press” one or more keys by saying press followed by the name of the key(s). 

 Dragon offers “shortcut commands” to search your PC for items containing specified words. For instance, to find all 
indexed e-mails containing “budget” and “Canada,” say search email for budget Canada. 

 If it detected that your PC’s resources wouldn’t allow maximum speed and accuracy, Dragon may have disabled its 
Natural Language Command sets for Word, Excel, PowerPoint and WordPerfect. If you wish to use Natural Language 
Commands in one or all of these, enable them via the Option dialog. 

http://www.nuance.com/support/dragon-naturallyspeaking
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Using Dragon with the Internet  

This lesson introduces commands for typical Web-related actions, including shortcut commands. Be sure to see the Help 
for details about using your voice on the Web, including Web-related options.  

Note: some commands supported in Internet Explorer and Firefox are not supported in Chrome. See the Command 
Browser. 

 

The Web shortcuts 

Dragon includes commands you can say anytime to perform general Web searches as well as searches in specific 
categories (maps, news, products, images, videos) or websites, such as Wikipedia.  

You could say for instance ‘search images for purple chrysanthemum.’ Dragon will then present, in your default Web 
browser, the results your default search engine found for those words in its image category. 

A key benefit of these search “shortcuts” is that they can be used no matter what program is currently active on your 
screen. No need to first open or switch to your browser! 
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TIP: These commands let you take advantage of capabilities of search engines, such as conversions and calculations, 

as in ‘search the Web for 61 percent of 1500’ and ‘search Bing for 77 euros in dollars’. 

 

These shortcut commands can be disabled or enabled in the Options dialog. Controlled by the same option is a different 
type of Web shortcut: open top site for… Instead of presenting search results, this command directly opens the site 
corresponding to the top result for your command keywords. Using it can be the quickest way to open the site for an 
institution or Web application: for example, say “open top site for Gmail” or “open top site for Nuance Communications.”  

Before these shortcut commands are executed, Dragon opens a small dialog box to let you revise, replace, or augment 
your keywords. This lets you make your searches very precise, so you find what you want more quickly. This Edit Search 
Keywords box is controlled by an option enabled by default for Web and Desktop shortcut commands. Note: If you turn 
this option off, you may not see any action right after giving your command; the search engine needs a moment to 
complete its search.  

Social Media 

Dragon offers commands to quickly post to Facebook or Twitter. (If you wish to disable these, you can do so from the 
Options dialog.) 

There are two ways to create your post: 

 select some text in an editable document, then say "Post that to Facebook" or "Post that to Twitter."  

 append dictation directly in your command, as in the Web search shortcuts: say "Post to Facebook" or "Post to 
Twitter" immediately followed by the text you want to post. For example, “post to Twitter anyone know a great 
dentist in Burlington Vermont question mark.”  

Dragon then brings up a box where you can verify, augment or modify your text. After you click OK, Dragon makes the 
post for you.  

  

Note: What Dragon executes with these commands is just posting, as opposed to opening Facebook or Twitter. Showing 
you the post in its site is not part of the command’s execution. If you wish to see your new post using voice commands, 
you could say “open top site for Facebook” and then say “refresh page.” 

The browser extensions 

The following sections cover actions often performed in HTML pages. There are many more commands (see the Help and 
Command Browser). Whenever you use Dragon on the Web, whether for email or something else, your experience will 
depend on several factors, including: 

 the particular settings in your browser and in the Web-based application,  

 the design of the particular web page,  

 the browser you use.  

For Internet Explorer, Firefox, and Chrome, Dragon offers its full functionality, including the ability to click objects by 
name, thanks to its Web extension, a small component you download for your browser. Please see the KnowledgeBase at 
support.nuance.com for the latest details.  

../DNS13%20Doc/workbook/support.nuance.com
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Your browser will present a message asking for authorization to install the Dragon extension.  
 

 

Note: What Dragon can do differs among browsers. For example, “go to address bar” isn’t built-in for Chrome,  

Navigating to and within a Web page (Internet Explorer) 

Say go to address to go to the address bar; after entering a URL, say go there or press Enter. 

Say go back or go forward to click the Back or Forward buttons; say go home to access the homepage.  

Say add to favorites to add the current site to the Favorites list. 

Say refresh page (to stop a page load, you can say stop loading).  

Say page down or start scrolling down (then say stop scrolling). 

Say open new tab, switch to previous tab, close tab… 

Say next frame, previous frame, next pane… 

Say click close or press Escape to close a popup window. 

Accessing a specific item on a Web page 

These commands require the setting "Enable commands in HTML windows," which is on by default and can be found in 
the Options dialog under Commands. 

 

IMPORTANT: Dragon is always looking to match what it hears to possible commands. For HTML windows, you can 

choose to require ‘click’, because saying a word or phrase in isolation may activate a link instead of being transcribed—
see the Options dialog. This option is on by default.  

 

For all the following commands, if what you said matches multiple items on the screen, Dragon displays numbers next to 
them; to indicate the desired item, say choose 3 or the number of your choice. (If you need the numbers to go away, just 
say hide numbers.) 

You can click inks or other objects by saying their name or just part of it, preceded by the word ‘click’ or not.  



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 55 

 

You can also click objects by 
saying their type: 

 click text field 

 click image (note: some 
items look like text but are 
actually images.) 

 click button 

 click radio button (small 
circle) 

 click check box to select or 
unselect a check box. 

 click list box then show 
choices to display the list 
(to highlight list items, you 
can use go down n) 

 

You can also say show links, 
which numbers all clickable items 
on the page 

 

 

 

 

 

Key points about Dragon and the Web  

 Dragon includes commands you can say anytime to perform general Web searches, as well as searches in 
specific categories (maps, news, products, images, videos) or specific websites, such as Wikipedia. 

 The shortcut command “open top site for…” can be the quickest way to open the site of an institution or service, 
no matter what is active on your screen. 

 The shortcut commands can be disabled in the Options dialog.  

 Before executing these commands, Dragon opens a box which lets you revise, replace, or augment your 
keywords; this box can be disabled in the Options dialog. 

 Dragon offers commands to post to Facebook or Twitter; you can disable these from the Options dialog. 

 Dragon is always looking to match what it hears to possible commands. For links, Dragon requires first saying 
‘click’ because saying a word or phrase in isolation could activate a link inadvertently. (This requirement can be 
turned off in the Options dialog.) 

 Dragon will prompt you to download the Dragon Web Extension for your browser. 

 For specifics on what Dragon can do in each Web browser, see the Help and the Command Browser. 
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Using Dragon for E-mail  

“Voice-typing” in itself is a great benefit for e-mail usage, but for certain e-mail applications, Dragon lets you do much 
more. This lesson introduces important commands and tips for using Dragon with e-mail, including shortcut commands 
and popular Web-based email programs.  

 

IMPORTANT: Although Dragon can automatically format email addresses and URLs as you dictate them, it can be 

efficient to add to the Vocabulary addresses and domains you use frequently (specify Spoken forms as needed). Take 
advantage of Dragon’s tool for adapting the Vocabulary based on sent emails and finding Contact names to add. (See the 
Help menu’s Improve my Accuracy.)  

 

Shortcut commands 

Dragon has many commands for use in Microsoft Outlook, including in the Inbox (to forward, move, or flag messages, for 
instance) and in the Calendar.  

For creating messages, appointments, meetings and tasks quickly, Dragon offers “shortcut” commands that work no 
matter what is active on your screen. At any time, you can say for instance: 

 create email to Jane Miller and Payroll 

 schedule meeting with Joe Keller and Jane Brown 

 create appointment at noon 

 schedule appointment on August fifteenth 

 create task about office supply inventory 

 email the selection to Jane Miller (“the selection” being the selected text or file).  

You can see all wordings for these in the Command Browser’s “Dragon – Shortcuts for E-mail” Context.  

Note: Before using these commands, make sure Dragon is able to recognize unusual words such as the names you plan 
to mention (use the Accuracy Center).  

 

These shortcut commands can be 
disabled or enabled from the checkbox 
"Enable E-mail and Calendar 
commands" in the Options dialog. 

 

 

To see more commands, take advantage of the Help: for instance, say “search help for Outlook calendar.” 

Commands for your installed email program 

You can start your default e-mail program by saying Start mail.  

With the program’s inbox open, you can say: 

new mail – creates a new mail message 
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open mail – opens the mail message highlighted in the list 

close mail – closes the open mail message 

forward mail – forwards the highlighted or open mail message 

reply to mail – replies to the highlighted or open mail message 

delete mail – deletes the highlighted or open mail message 

check for new mail – checks for new mail/opens your Inbox 

Note: In e-mail commands, you can substitute the words message, e-mail, or memo for mail. 

 

TIP: In lists of messages or folders, you can use navigation commands like go up 4 as well as go to top and page 

down. 

 

When in a message, you can move between its fields by saying tab or the following commands naming the desired field 
(the word “field” is optional): 

go to To [field]  

go to CC | BCC [field] 

go to Subject | Body [field]  

 

Dragon has hundreds of mail-related commands. To find wordings for an action that interests you in a particular mail 
program, use the Command Browser: in its Browse mode, use the “Context” drop-down list to pick the program, then use 
“Keyword Filter” to enter one or more words related to that action.  

In Outlook, you can also use your voice to move the selected email to a particular folder. For example, if you have an 
Outlook folder called “Ideas” and want to move the selected email to it, you could say “move selection to ideas folder”. (To 
see more wordings, see the Command Browser under “Dragon – Shortcuts for MS Outlook.”) 

Web-based email and the Dragon extension 

Whenever you use Dragon on the Web, your experience will depend on several factors, including: 

 The design of the particular web page at that time  

 The particular settings in your browser and in the Web-based application  

 What browser you use. For example, you can’t the command “Go to Address Bar” in Chrome. 

For full functionality, Dragon will prompt you to install its Web Extension (a small component) in your browser.  
 

Full Text Control and the Dictation Box 

On most web pages, you have Full Text Control: Dragon capitalizes the first word, adjusts spacing, supports Playback, 
and supports commands that quote from your text, such as “insert before <xyz>” and “correct <xyz>.”  

In places without Full Text Control, such as in Google Docs, you can work through the Dictation Box. You can also work 
directly, in which case you will benefit from the following: 

 Say “cap” before the first word 

 If you need to insert within existing text, say “spacebar” to add a space. 
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Navigate fields and folders 

To access a particular folder, such as Drafts or Inbox, say “click” followed by the label. 

To navigate between fields, say “tab,” “tab n times,” or “click text field” then the number of the desired field.  

Note: 

 Whether using Dragon or not, it’s prudent to leave the To field blank until you’re ready to send! (Also prudent is 
setting up other protection such as an delay before the program actually sends.) 

 In addition to keyboard shortcuts of the Web browser itself, you may wish to take advantage of those of your 
particular Web-based email, such as “press control enter” to send a message in Gmail. Lists of shortcuts are 
available on the Web, including on the websites of Google and Microsoft.  

 

 

 

Key points about e-mail  

 In e-mail commands, you can use the words message, e-mail, memo, or mail interchangeably. 

 For Outlook, Dragon lets you use shortcut commands like book meeting with <contact(s)>, create message to 
<contact(s)>, create email about <subject>, and create task about <subject>, at any time, no matter what 
application has the focus (no need to first switch to Outlook). These commands help you quickly act on a thought 
with minimal interruption to what you are currently doing.  

 Thanks to its Web extension for Internet Explorer, Firefox, and Chrome, Dragon offers Full Text Control in most 
websites (Google Docs and Word Online are exceptions) and the ability to click objects by name.  

 For the Web extension to be active after you download it, close and re-open your browser.  

 See more commands in the Command Browser and details in the Help (for instance, you could say “search help 
for Outlook calendar”). 
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The Office Ribbon and Microsoft Word 

In “Controlling the Operating System and Applications”, you learned about Natural Language Commands. Since Microsoft 
Word is a word processor many people use, this chapter lists built-in commands for it. (Remember: if system resources 
are low, enabling Natural Language Commands could decrease Dragon’s speed.)  

In addition to commands, this chapter covers a special point of interest for Word: the Voice Notation feature. 

 

The Ribbon interface 

Starting with Office 2010, Microsoft replaced application menus with a ribbon of tabs. The tabs display the controls that 
are most relevant for each of the task areas in the application, such as changing the font or zooming.  

This ribbon can be toggled on or off by clicking on the small arrow in the top right corner. To minimize the ribbon by voice, 
you can say “minimize ribbon” and to expand it, “maximize ribbon.” (In ribbon commands, you can also use the verbs 
“pin,” “show,” “toggle,” “collapse,” “expand,” “unhide,” and “view”.) 

The File tab 

The other tabs can be accessed by voice by just saying their name, but for the File tab you must include the word tab, as 
in “click file tab”.  

Note: Windows 7’s WordPad has an unnamed button instead of a File menu. To click it, you can say “click application 
menu”. 

Read Mode 

Word 2013 introduced a new layout called Read Mode, which aims to make it easier to read documents and perform 
related tasks such as obtaining the definition or translation of a word.  

When in Read Mode, you cannot use Dragon to dictate or perform selections or corrections in the open document, even 
though the DragonBar indicates that Dragon has Full Text Control. However, it is possible to dictate and perform 
operations when you are in a Comment field in Read Mode. 

For details on support for Office, please see Dragon’s Help and website.  

Discovering commands 

For popular applications like Word, Dragon has so many commands (and many different wordings for most commands) 
that we couldn’t possibly list them all here or in the Help.  

If you are in a supported application and you think of an action you’d like to perform by voice, use the Command 
Browser’s Context list to pick that application and use its Filter to see just the commands that contain a particular word 
or words. If you see a command that looks interesting, make sure it’s highlighted in the list, then use the Browse menu to 
uncover its full wordings (for instance, to include all optional words or expand ellipses). 

Note: If you say what you think is a command but Dragon takes no action or just transcribes the words on the screen, look 
for the Results indicator. If it doesn’t show your command, Dragon didn’t recognize what you said as a valid command for 
the current situation: for instance, if you say "insert a 2 by 2 table" when the insertion point is inside a table, nothing 
happens because Word doesn’t allow inserting a table inside a table 

Here are examples of commands for Word: 
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 New file 

 Save the file. Save file as. 

 Insert a 3 by 7 table  

 Add page numbers [at bottom left | center | right] 

 Delete next sentence 

 Find a word. Find and replace. 

 Set page orientation to Landscape 

 Print pages 3 to 7. Print the selection. Print [this] page 

 View page layout. Change view to print layout. 

 Zoom to 50 percent. Zoom to full page. Change zoom to page width 

 Set page width to 8 inches 

 Show | Hide paragraph marks 

 Double-space the document. Single-space this paragraph 

 Set the font color to green in this line 

 Set background to yellow 

 Show word count 

Here are more commands, grouped by their tab in Word’s Ribbon:  

Page Layout  

 Create a watermark 

 Set the page color 

 View themes 

 Create line numbering continuously. Delete line numbering 

References  

 Previous footnote 

 Create citation/caption/index 

 Add that in index 

Review  

 Open research pane 

 Translate first sentence. Translate entire page 

 Create new comment. Delete all comments shown. Go to next comment 

 Hide/close [the] review pane 

 Accept change and go to next 

“Voice Notations” in Word documents 

In Word, Dragon lets you add “Voice Notations”: text that can later be used with Word's Accept/Reject Change 
functionality. A Notation could be anything you do not want permanently in your document or you do not want transcribed, 
e.g. instructions you speak for the benefit of your assistant. Voice Notations are not used by the Acoustic and Language 
Model Optimizer.  

To add a Voice Notation, press the Esc key while dictating. Voice Notations are highlighted in green and formatted as red 
italic text.  
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Dictating and editing in Microsoft Excel 

You can use Dragon to dictate and edit content into Excel spreadsheets. Many Excel-specific commands are built in; the 
Command Browser lets you discover the full set. The Help describes commands to fill or hide rows or columns, sort, sum 
or average values, widen columns, and more. 

Remember that the Natural Language Commands for Excel may be disabled or enabled from the Options dialog. 

In this lesson, sample steps guide you to practice tasks such as entering text, moving between cells, editing existing cells, 
and correcting errors inside cells. 

 

IMPORTANT: If you want to mention a cell in a command (such as “move to cell D5”, or “select cell B3 through cell 

H3”), be sure to say the word “cell” in your command. Note that, instead of the letters, you can say alpha, bravo, Charlie, 
etc. 

 

There are two editing modes in Excel: Quick and Full. Make sure you are familiar with how your version of Excel 
functions, especially for editing content in cells; notice when the Status Bar (bottom left) indicates “Edit” as opposed to 
“Enter” and when the mouse pointer changes. 

 Quick Edit: To enter new content into a cell, overwrite the current content of a cell, or format the entire content of 
a cell. When you select a cell and begin dictating, a yellow background appears; if the cell currently contains text, 
the dictated text will overwrite it. 

 Full Edit: To edit the existing contents of a cell. Select the cell and say "Edit Cell" or "Press F2" to open the cell for 
editing; the insertion point is automatically placed at the end of the cell. As you dictate, the background changes 
to blue. Commands such as "New Line" operate within the cell.  

 

TIP: To quickly enter a predictable series of values, such as days or months, you can use commands such as “Monday 

through Friday across” or “July through December down.” 

 

 

Full Text Control in Quick Edits 

You will want to practice entering data into a spreadsheet and navigate around the spreadsheet and within cells, as well 
as dictate and modify text using commands like “correct <xyz>” (see Full Text Control). 

For the exercise below, the content of the spreadsheet is not important.  
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Step 1: Open Excel, say open document and locate 
the sample spreadsheet or use a blank file.  

Step 2: Say move to cell C7 (or Charlie seven.)  

Step 3: Dictate your full name into the cell. 

As you dictate, the cell background turns pale yellow, 
indicating that Dragon is doing a Quick Edit. 

 

 

 

Let’s practice correcting recognition errors so Dragon can learn from them: 

Step 1: Say move to cell C 14 (or Charlie 14). Dictate some text that is likely to contain unknown words, such as: “Travel 
to Ashtabula to provide support for Sporkatron, Inc.” 

Step 2: Correct one of the recognition errors. (Leave the remaining errors as they are, so you can practice coming back to 
this cell and correcting them later.) 

Step 3: Say move down one to go to cell C14. Dictate some additional text that is likely to contain new words, such as: 
“related to last week’s trip to Kenmawr—training Moosehart Insurance” 

 

Now that you are out of the cell, practice going back to it and correcting the error(s) in it. 

Step 1: Say move up one to move back to cell C13. Say a “correct <xyz>” command to correct another of the errors 
Dragon made. Notice that the cell again turns yellow. 

Continue correcting the text until it is accurate. 

Step 2: Say apply. You are no longer in Quick Edit mode; the cell you were editing is still selected. 

 

Now let’s practice entering numeric data rapidly into a row. 

Step 1: Say move to cell B16 or move to cell Bravo 16 to move to the Breakfast row. Dictate a numeric value such as 
six dollars and fifty cents. 

Step 2: Say move right one to move to the next Breakfast entry. Fill in the rest of the row. 

 

Key points about editing cells in Excel 

 You can navigate between cells using absolute commands such as move to cell A1 or relative movement 
commands such as move up 1. 

 To mention a cell in a command (such as move to cell D5 or select cell B3 through cell H3), be sure to say the 
word “cell”. You can speak the letters as alpha bravo Charlie, etc. instead of A B C.  

 To modify and add to the existing content of a cell, move to that cell, then say Edit Cell or Press F2; the insertion 
point will appear at the end of the content and the cell will have a blue background. If you say commands like New 
Line and New Paragraph, these commands are executed within the cell. 
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 If you just move to a cell and start to dictate, what you dictate will overwrite the existing content. 

 You can use commands like correct <xyz>, and insert before <xyz> to modify text in a cell. 

 To complete an entry and move down one cell, say press Enter. To cancel an entry and remain in the cell, say 
cancel or press Escape. 

 Saying apply completes entry into a cell, and leaves the focus on that cell (exiting Quick Edit mode). 
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Boosting Productivity with Custom Commands 

In previous lessons, you learned various built-in commands to perform actions such as formatting text, searching the 
Internet, creating a new e-mail, creating a new appointment… Dragon also allows custom commands. 

There are several types of custom commands; this workbook presents the “Auto-text” (“Text-and-Graphics”) type, which 
allows you to define boilerplate for Dragon to paste wherever you utter the command. This boilerplate can contain 
graphics, such as logos, scanned signatures, maps… Easy to create, these commands provide additional time savings 
and convenience. You can even include fields in them—a quick way to create templates that can be both created AND 
navigated by voice. 

 

Creating boilerplate commands 

Step 1: Say add new command or choose Add New Auto-Text or Add New Command in the Tools menu.  

Step 2: Think of a name for your command and enter it. This is the phrase you will say to cause the 
command to execute. Choose it well! It should be easy to remember and easy to say, like Paste 
Signature and Enter Home Directions. 

 

 

 Choose a descriptive, meaningful name (as opposed to a name like “macro 3”.) 

 Make it neither long nor short (between 2 and 5 words is usually best). Avoid single words, and phrases you’re 
likely to dictate, such as your name. 

 Use words that are easily pronounced and recognized. All words in the command name must be in the 
Vocabulary.  Don’t use symbols—for instance, use “number” instead of “#”, otherwise Dragon would expect to 
hear “number sign” or “pound sign” when you say the command. 

Step 3: In the Description field, enter information about your command. This is optional, but it helps remember any 
important details about the command (its intent, when and where you might use it…). 

The following step applies to the MyCommands Editor as opposed to the Add New Auto-Text window. 

Step 4: Optionally, choose a group. In the Group field, you can highlight and overwrite the default. Creating commands 
groups can later allow you to locate and manage many commands quickly. Aim to name your groups 
meaningfully: for instance, the name of the application or task for which you are creating the command(s). 

Once a command Group is defined, you 
can add more commands to that group 
(Dragon will now include it in the “Group” 
drop-down). 

If desired, you can always assign the 
command to another group later. 

 

Step 5: In the body field, enter what you want Dragon to paste when you say your command. (You may find it helpful to 
maximize the window so that a larger field is visible.) 

 

TIP: If the text you want already exists in electronic form, you can save time: highlight the desired segment in the 

document, then say “make that a command”. Dragon automatically opens the Editor and pastes your selection in the 
Content field. All you have to do now is specify the command’s name and attributes, and edit the content as needed.  

 

As its name suggests, this type of custom command lets you include graphics as well as text: in the Content field, 
you can paste images such as maps, logos, or a scanned signature. 
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Optional: If desired, format the text in the Content field. Clicking the Aa button opens the Font window, where 
you can choose the desired font style, size, color, etc.  

 

 

TIP: If you want the content to match the format of what precedes it in your text, check the Plain Text checkbox. 

 

Step 6: Once the command is named, edited, described, grouped, and formatted as you want it, click Save. 

Now let’s test your command. Say start DragonPad, then say your command’s name. (Follow the usual rule: pause 
before and after, but not in the middle!)  



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 66 

 

You may realize now that you could make your command even more convenient: for instance, by adding a blank line at 
the top so your pasted content automatically starts as a new paragraph. The below explains how to edit a custom 
command. 

“Cloning” commands and adding variables 

Instead of making a command from scratch, you can create a new command based on the “clone” of an existing one, by 
clicking New Copy on the Command Browser’s menu or by clicking the Create New button on the MyCommands Editor. 

In addition, the MyCommands Editor’s Name Editor allows the inclusion of <variables> in your command names. 
Variable names provide flexibility, so you can use synonyms instead of just one wording, and can make your custom 
commands even more useful by having them perform variations on the same action.  

The variables can be synonyms, or they 
can be different values, such as numbers 
from 1 to 10.  

<1to10> is one of the pre-filled lists 
available through the Name Editor, but 
you can also make your own (as was 
done for <hq_nuance> in this lesson’s 
illustrations).  

See the Help for details. 

 

 

Boilerplate commands with fields 

Dragon lets you easily paste a template containing voice-fillable fields. To create a field in a command’s body, click the 
Insert Variable button in the Command Editor. By default, each field appears between square brackets as "[default 
value]". (If you prefer delimiters other than square brackets, you can indicate that in the Options dialog.) 

After saying the command’s name, which pastes the template, you can: 

 type or dictate a specific value in each placeholder —> The placeholder is overwritten, and delimiters are 
removed. 

 accept the default value —> Delimiters are NOT automatically removed; you can say "clear variable delimiters". 

To navigate a template’s fields, you can select the desired field with the mouse or say the commands "next field" or 
"previous field." (These commands only work where all the DragonBar’s Full Text Control indicator is green). 

Managing custom commands 

You may wish to edit a custom command (if your phone number changes, for instance, you would edit commands that 
contain it). You may also want to rename, delete, or copy a custom command.  

To do so, you can open the Manage Custom Commands dialog from the Tools menu. You can also use the Command 
browser as follows.  
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Step 1: Say open Command Browser. (You can also use the link in the Tools menu.) 

Step 2: On the Mode section of its Task Pane, click Manage (or choose it from the Mode menu). 

Step 3: Open the Group drop-down list. If you created a separate group as mentioned earlier, its name will appear here; 
choose it. Otherwise, the commands you made will be under User-defined. 

Step 4: The Command Browser now displays only the commands in the specified group, listing them by availability. You 
can use the + symbol to expand the display. 

Step 5: Check the box next to the desired command, then click To Script in the Task pane.  

 

This takes you to the Command Browser’s Script display, which shows all the modifiable commands. Notice the 
items available in the Task Pane. 

Step 6: With your command highlighted, click Edit in the Task pane (or use the Script menu). The MyCommands Editor 
will open, showing the command’s attributes and content; you can now edit them as desired. 
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Note: 

 You can delete commands visible through the Script or Manage displays: check the box next to the desired 
command(s) then choose Delete (from the menu). 

 Giving your command a Description is useful to note where and when the command should be used, or 
reminders like “make variations of this ASAP” or “change the address after we move.” Your notes may seem 
obvious at the time you write them, but they may really help later! 

Finding commands with the Keyword Filter 

One way you can find commands in the Command Browser is by filtering the display to show only the commands whose 
name contains a particular word or words: use the Filter list visible from the Command Browser’s toolbar when in Browse 
mode.  

The Filter is useful for finding custom commands (particularly if they were not filed under a Group name) and also finding 
built-in commands, since Dragon contains far too many to list even in the online Help.  

 

TIP: It’s a good idea to explore the Command Browser for commands related to items you might like to address by 

voice: you might filter for words like border, indent, double space, table, row, column… 

 

The Command Browser’s display may seem difficult at first, with some lines containing ellipses (dot dot dot), parentheses, 
and <angle brackets> to represent optional and alternate elements like “the” and “a.” You can view full wordings by using 
the Browse menu—Show All is particularly useful. 
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To practice, pick your word processor in the Context list and use the Filter to find commands on items you often use, such 
as bullets, numbers, or tables.  

 

 

 

Key points about custom commands 

 You can quickly create custom commands to insert blocks of text and/or graphics in your documents. This can be 
done in the Add New Auto-Text Command window, from the Tools menu.  

 If the boilerplate text already exists in an electronic document, you can save time when creating the command: 
select the text then copy and paste it or just say make that a shortcut. 

 It’s a good idea to use the Command Editor’s Description field to note a comment or a reminder, for yourself or 
potential other users of your command. 

 Names for custom commands should be memorable, intuitive, easy-to-pronounce phrases. Avoid names that 
Dragon could recognize in the course of your dictations, such as single words.  

 The Name Editor lets you add <variables> in command names, to provide synonyms or variations, using lists 
you define yourself or existing lists such as <1to10>. 

 You can add fillable fields to your boilerplate commands to create templates which can be navigated and filled out 
by voice. 

 You can rename, modify, copy, delete, export and import custom commands.  
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Performing Audio Checks and Training 

As described earlier, personalizing Dragon’s vocabulary is a small investment of time that makes a big difference in how 
accurately the software can work for you. In addition, when misrecognitions do happen, correcting them allows Dragon to 
learn from its mistakes.  

In certain cases, you may also want to perform acoustic training to improve accuracy. This lesson presents how to train 
individual words or phrases, as well as how to use the Microphone Check, a short but important process. 

 

IMPORTANT: When providing Dragon with acoustic training, be sure to use your natural dictation voice: relax, and 

speak clearly but not louder or slower than you would when dictating normally. Otherwise, you give the software acoustic 
data that is not representative of how you usually dictate. Remember, to train the software to accurately recognize your 
speech, you must represent your speech accurately! 

 

The Microphone Check 

Use Dragon’s audio check if something in your environment has changed: new computer, new microphone, new room, 
different ambient noise, etc. Also, if your overall accuracy is lower than expected, you want to verify that your audio 
hardware is functioning correctly.  

Note: when this Wizard opens, Dragon automatically turns off its microphone. 

Step 1: From the Audio menu, click or say Check Microphone, which opens the microphone check wizard (formerly 
called the Audio Setup Wizard).  

You can also bring it up directly by saying check microphone. 

Step 2: As when you first created your profile, read the content of the box. Dragon will indicate whether the check passed.  

If it fails, verify that your microphone is plugged in correctly and its listening side is facing your mouth. (The 
listening side may have under the foam cover.) There may be a problem with background noise (including “subtle” 
noises such as your building’s temperature-control system) or with your audio hardware. See the Help. 

Acoustic training in isolation 

You learned to add new words and phrases to the vocabulary as well as to create Spoken forms for items pronounced 
differently from the way they are written.  

Spoken forms are often the most efficient way to ensure recognition, but if you suspect that Dragon needs help 
recognizing a tricky word, particularly if it contains a sound you can’t represent in writing (such as a rolled r), you can 
“train” that word by pronouncing it. 

Step 1: In the Vocabulary Editor, locate the word you wish to train. 

Step 2: Click the word in the list so it is highlighted, then say or click Train. The Train Words window opens. Are you 
ready? (If you need to clear you throat, do it first!) Click Train and read the prompt in your normal speaking voice, 
as if you were saying this word in the middle of a sentence. 
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Step 3: You may have to 
wait a second for 
this acoustic 
information to be 
incorporated. Then 
click Save. 

 

 

 

 

 

Key points about acoustic training 

 In general, the best thing you can do to make Dragon recognize your speech even better is use the software 
regularly, personalizing the Vocabulary (editing Spoken forms or Word Properties as warranted, designating 
documents for Dragon to analyze, running or scheduling the Accuracy Tuning process…) and correcting 
misrecognitions.  

 In certain cases (if a certain word is consistently misrecognized, or if overall accuracy is lower than you expected), 
you will want to provide Dragon some additional acoustic data. 

 You can train Vocabulary entries from the Vocabulary Editor (either one at time or several at once). 

 Speak as you typically do when you dictate to Dragon. It’s important to avoid the temptation to over-enunciate or 
speak loudly when training a word or phrase in isolation. 

 At any time, if you feel that the accuracy is not as high as usual, you can access Dragon’s Microphone Check 
through the Audio menu or the Accuracy Center, or by saying Check Microphone. 
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Using Multiple Vocabularies 

The advantage of having several Vocabularies is being able to customize each one to perform best for very different 
topics or styles of dictation. For instance, suppose an architect uses Dragon to dictate business letters and site reports, 
but also frequently uses it for his community theater group. In his work-related dictations, he might use formal business 
language and mention technical terms, brands of materials, the abbreviations for building codes, as well as the names of 
clients, contractors and other work contacts. When writing for his theater group, however, his dictation style might be 
casual and the words he uses frequently would be different. 

 

Creating a vocabulary 

The process starts in the Manage Vocabularies dialog box.  

Step 1: Say Manage Vocabularies or use the 
DragonBar’s Vocabulary menu. Click New.  

 

Step 2: In the New Vocabulary window, enter a 
descriptive name in the Name field. From the 
drop-down, choose the vocabulary on which 
you want to base your new vocabulary (what 
you see in the list varies if you have the Legal 
edition). 

 

If you want your new vocabulary to contain the customizations already present in your existing vocabulary, 
choose this existing vocabulary. Otherwise, choose the Base vocabulary.  

 

Step 3: Dragon will then offer to perform a basic adaptation of this new vocabulary based on documents found on your 
computer or sent emails. This process may take a while. You can choose Cancel then customize your new 
vocabulary using what you learned in previous lessons.  

Remember that designating documents for Dragon to analyze is particularly important for good accuracy, in 
addition to adding Written forms and Spoken forms to the vocabulary (see the Accuracy Center). 
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Managing Vocabularies 

After creating (or importing) a new Vocabulary, you may wish to rename or delete it; both are done in the Manage 
Vocabularies dialog box, accessible from the Vocabulary menu.  

From Manage Vocabularies, you can also Export a Vocabulary, to save it to a shared or portable drive, for instance.  

This would allow you to share it with other Dragon users: the recipient user just needs to open the Manage Vocabularies 
dialog, choose Import and browse for the exported Vocabulary’s .top file. See the Help for details. 

 

Opening a Vocabulary  

During your dictation session, you can switch to a different Vocabulary by saying open recent vocabulary. 

If you have multiple Vocabularies for the same profile, this will be reflected in the Open User Profile window, which will 
appear when you start Dragon. 

The Open User Profile window also shows the different audio source(s) that may be available for the profile(s) present on 
your computer. You can pick the line containing the Vocabulary you wish to open.  
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Key points about multiple Vocabularies 

 If you dictate on two or more very different topics, using different customized Vocabularies will maximize your 
recognition accuracy. Each Vocabulary can be customized using the tools in the Accuracy Center—adapting to 
documents you designate, for instance. 

 If you have several Vocabularies, you will be prompted to choose one when you start Dragon. You can switch to a 
different Vocabulary later, by saying open recent Vocabulary, for instance. 

 The Manage Vocabularies dialog lets you create, delete, open, rename, import and export Vocabularies; it opens 
with the command manage Vocabularies (or from the Vocabulary menu). 
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Automatic Optimization and Backup 

Vocabulary customization and proper correction of recognition errors both help Dragon recognize your dictations more 
accurately. “Accuracy Tuning” is a functionality you can use to further “tune” your profile’s accuracy for your specific 
usage. It has two aspects: 

 refine your profile using the latest acoustic data from your dictations, corrections, and transcriptions.  

 use text from your usage to add frequent word sequences to the Language Model -- statistics Dragon uses to 
determine what words and spellings it should write when you dictate. 

 

IMPORTANT: If you have recently dictated in a very different sound environment, such as an airplane, you should 

not let Dragon perform Acoustic Optimization. 

 

 
When your profile is saved (for instance, when you close Dragon or your profile), Dragon may offer to optimize the 
Language Model based on the text data of your recent dictations. The Save User Profile dialog box will contain a 
checkbox for performing “maintenance.” Note: This process takes little time. Language Model Optimization is much 
quicker than Acoustic Optimization because the data it processes is just text. 

The Accuracy Tuning process becomes available once you have used Dragon for a while (the software builds up an 
archive when you perform dictations, corrections and training). A message box will let you know once Dragon has enough 
for its automatic optimization. 

How much of an accuracy boost you will get from Accuracy Tuning will depend on factors such as the amount and quality 
of the initial training and optimization (if performed during profile creation), the initial accuracy you experienced, and the 
amount and quality of text and audio data available for processing. 

You can choose to schedule the two components, Acoustic Optimization and Language Model Optimization, to run 
periodically at a time and frequency of your choice. You can also launch one or both yourself. 

Launching the Acoustic and/or Language Model Optimization 

Step 1: Use the Audio menu (or the Accuracy Center’s Accuracy Tuning link).  
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Step 2: Check the optimization(s) desired then click Go. Note: Language Model optimization is typically much faster than 
Acoustic Optimization. 

Profile Optimization, User Experience Collection, and Backup 

For convenience, Dragon lets you schedule a specific time and frequency for these optimizations. You can do this at the 
time you create your profile, and you can also do it later by going to the Administrative Settings dialog (available from 
the Tools menu) and using its Scheduled Tasks tab. 

 

IMPORTANT: When you schedule a Dragon task, pick a time when your computer will be on (not sleeping, not 

hibernating) but Dragon won’t be running (not even in its QuickStart mode). 

 

The documentation contains details about how end-users and Administrators can access these optimizations and 
Dragon’s scheduling (the latest documentation is available on the Nuance website).  

 

In addition to Accuracy Tuning, Dragon allows you to schedule another periodic task: the automatic collecting over the 
Internet of usage metrics such as which settings you have, which commands you use often, how you make corrections, 
which language you use, which processor is on your computer, and what edition of Dragon you have. This option helps 
Nuance’s Research & Development team learn what customers around the world use and need, so Nuance can improve 
Dragon; you can choose to disable or enable it at any time.  

Take a look at the Data page of the Options dialog. It also includes the setting for the frequency at which Dragon makes a 
backup of your profile (by default, Dragon does it every five times your profile is saved). 



 

Copyright  2016 Nuance Communications, Inc. All rights reserved 77 

 

 

 

 

   

Key points about automated optimization and backup 

 Acoustic and Language Model Optimization can automatically “tune” your profile by “reviewing” the acoustic data 
and/or text data it has gathered from your usage of Dragon so far.  

 Optimization can be launched at any time from the Audio menu or the Accuracy Center. It can also be scheduled, 
so that Dragon performs it at a specific frequency and time.  

 Language Model optimization is typically very fast. You can schedule it to run daily. 

 The Options dialog has settings for automatic profile tuning, data collection, and backup. 

 When scheduling Accuracy Tuning or User Experience Collection, pick a time when your computer will be on but 
Dragon won’t be running. 
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Renaming, Deleting, Copying or Transferring a Profile 

As you learned, each person who uses Dragon creates a User profile, which the software holds in a set of files that 
contains, among other things, acoustic and lexical data. When you add a personalization to the Vocabulary (spoken form, 
alternate written form, capitalization property…), correct a recognition error, read a training text, or change an option, 
Dragon can save these changes in the open profile.  

Although Dragon automatically creates a profile backup (by default, every five times the profile is saved), it’s a good idea 
to keep your own record of customizations, by exporting your custom words and commands, for instance, or noting what 
options you like.  

You can also copy your whole profile, for safe-keeping or to make it available on another computer. Transferring a profile 
is a simple two-part process accomplished through the Manage User Profiles dialog box.  

 

Step 1: Say manage user profiles (or use the Profile menu). In the Manage User Profiles dialog, select your profile, pick 
Advanced then pick Export. (You may see a message about saving the current profile.) 

Step 2: A Browse dialog opens. Choose a destination (if you wish, make a new folder) then click OK.  

If both computers share a network drive, this drive is probably the easiest location. Otherwise, you can export 
your profile to a storage device such as a portable USB drive.  

 

Now that your User profile is exported, it can be imported:  

Step 1: From the second computer, open the Manage User Profiles 
dialog. Choose Advanced> Import. 

Step 2: When the Browse window opens, locate the folder containing 
the exported profile (this folder bears your profile’s name). 
Once it is highlighted, click OK. 

 

 

 

The Manage User Profile dialog box also enables you to rename or delete a profile, as well as to see a profile’s 
Properties (such as its source(s), backup location, and date of last backup). 

Note: if you frequently work from different computers, explore Dragon’s Roaming feature. 
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Key points about exporting and copying a profile 

 Transferring a profile is done through the Manage User Profiles dialog box—available through the Profile menu or 
by saying manage user profiles. 

 You must export the profile from the original computer, then import it to the recipient computer. 

 

The Help contains more information about managing profiles: deleting, renaming, backing up, restoring… See for instance 
topics on the Roaming feature, which presents administrative advantages and is particularly useful for people who 
frequently dictate from different PCs connected to the same network. 
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Practice Exercise: Creating a Memo by Voice 

For this exercise, open DragonPad or another supported word processor. Try to create and format the following document 
entirely by voice. After you create the sample signature block shown in the sample below, replace it with your own contact 
information.  

Take this opportunity to practice looking up keywords in the Help to find out more ways to accomplish a particular task. 
Remember the commands “what can I say” and “search Help for…” as well as “quote that”! 

 

 

August 5, 2016  

AnyCorporation 

Gene Hansen-Wolffe 

P.O. Box 3299 

Minneapolis, MN 67812-3299 

 

 

 

Dear Gene, 

 

I am pleased to report that “my” team has reviewed the Western Region Report for this quarter. As of July 
29, 2016:  

 

the total is $875,500 [as we expected]. 

 

Please let me know your projected figures for the rest of Q3.  

 

As always, don’t hesitate to contact me at the number below. 

 

Sincerely, 

 

Sara Petersen 

Regional Sales Manager 

My Company, Inc. 

202-965-5000 

mobile: 715-377-1925 

fax: 800-968-2231 

sara.petersen@mycompany.com 
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